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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may 
be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.  

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous 
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).
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Preface

This virtualization user manual describes how to leverage virtual image 
templates when deploying a virtualized PlantPAx® Distributed Control System 
(DCS). PlantPAx virtual image templates are pre-configured, virtual system 
elements of your PlantPAx system.

This manual also describes how to manage and configure templates as 
individual virtual system elements, and how to configure them to work 
together.

Figure 1 -- PlantPAx System Implementation and Documentation Strategy

• Define and Procure - Helps you understand the elements of the 
PlantPAx system to make sure that you buy the proper components.

• Install - Provides direction on how to implement the PlantPAx system 
architecture to help develop your application. 

• Prep - Provides guidance on how to get started and learn the best 
practices for developing your application. 

• Develop - Contains the application-specific libraries and objects 
that are used to construct your application that resides on the
PlantPAx architecture.

• Operate – Provides guidance on how to verify and maintain your 
systems for operation of your plant.

Define and
Procure PrepInstall Develop Operate

• Selection Guide
PROCES-SG001

• Virtualization User Manual
9528-UM001

• Infrastructure User Manual
PROCES-UM001

• Reference Manual
PROCES-RM001

• Application User Manual
PROCES-UM003

• Reference Manual
PROCES-RM001

• Library of Process Objects
PROCES-RM002
PROCES-RM013
PROCES-RM014

• Verify and Troubleshoot User Manual
PROCES-UM004
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Preface
Summary of Changes

This manual contains new and updated information as indicated in the 
following table.

Purpose of This Manual

Virtualization is the abstracting of the operating system from the hardware to 
enable running multiple virtual machines on one piece of hardware. This 
manual shows how to use templates to configure virtualized system elements.

Virtual image templates are provided for the following PlantPAx 
system elements:

• Process Automation System Server (PASS) 
• Engineering Workstation (EWS) 
• Operator Workstation (OWS) 
• SQL Server - AppServ-Info (SQL)
• Process Automation Domain Controller (PADC)
• Historian Server - AppServ-Info (Historian)
• Batch Management Server - AppServ-Batch 
• Asset Management Server - AppServ-Asset 
• Operator Workstation Application Server - AppServ-OWS 
• Engineer Workstation Application Server - AppServ-EWS 
• VantagePoint Server - AppServ-Info (VantagePoint)

In addition to these virtual templates, this manual has deployment instructions 
for the consolidated PASS (PASS-C) and associated OWS (OWS ISO). The 
PASS-C and OWS ISO are designed to deploy on a physical machine.

Topic Page

Added chapter 3 for initial server configuration. 87

Updated chapter 4 for updated workflow and graphics 97

Added chapter 5 for initial workstation configuration 165

Updated chapter 6 for updated workflow and graphics 173

TIP Skip to Chapter 6 if you are deploying a PASS-C or OWS ISO.
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Preface
Before You Begin

• PlantPAx virtual image templates, PASS-C, and OWS ISO USB devices 
are obtained by the following methods:
– Media - Order a physical copy of the virtual image template. End user 

is responsible for the proper Microsoft® licensing.
– Electronic Software Delivery (ESD) - Download an electronic copy 

of the virtual image template from the Product Compatibility and 
Download Center (PCDC) website. When you download the 
PASS-C or OWS ISO, you receive an ISO file that you can use to 
create a bootable device.

• Virtual servers require Microsoft OS License Keys for Windows Server 
operating systems. 

• Virtual workstations require a Microsoft OS License Key for Windows 
operating systems.

• FactoryTalk® Activation Certificates contain serial numbers and product 
keys for the Rockwell Automation® products that correspond to the 
templates.

See PlantPAx Virtual Image Template Catalog Numbers on page 10

• A domain controller must be configured and accessible on the network. 
• vSphere Web Client is used to deploy virtual machines. 
• vCenter server is optional and enables you to create your own virtual 

image templates and increase your ability to manage a virtualized 
control system.

IMPORTANT Our templates can be used with any virtualization software. We use 
VMware for the procedures in this document.

TIP Remote Desktop Services uses its own method of licensing clients 
that log on to Remote Desktop Services servers. This method is 
separate from licensing for the Windows Server family of operating 
systems. Therefore, AppServ-OWS and AppServ-EWS Remote 
Desktop Connections must receive a valid license. This license is 
issued by a Remote Desktop Licensing Server before they can log on 
to a Remote Desktop Session Host or Connection Broker.
For licensing of these components, contact your Microsoft 
distributor.

IMPORTANT If you already own individual product activations, these activations 
can also be used to activate the virtual image templates.
Rockwell Automation Publication 9528-UM001G-EN-P - June 2019 9



Preface
Microsoft Operating System 
Software Licensing

Each server or workstation instance that is deployed from a template, bootable 
device, or ISO needs its own Microsoft operating system license and Rockwell 
Automation software licenses.

The end user is responsible for properly licensing a Microsoft OS for each 
template deployed. Additional licenses can be purchased from your Microsoft 
distributor.

PlantPAx Virtual Image 
Template Catalog Numbers

Table 1 lists the catalog numbers for PlantPAx virtual image templates.

Table 2 lists the catalog numbers for PlantPAx USB devices.

Table 1 - Virtual Image Templates on USB Devices

Virtual Template Cat. No. Description

PASS 9528-PASSVTENM USB device contains the virtual image template for the PASS. The end user is responsible for acquiring the appropriate Microsoft OS 
license for Server 2016. All required Rockwell Automation software is pre-installed but not activated. 

EWS 9528-EWSVTENM USB device contains the virtual image template for the EWS. The end user is responsible for acquiring the appropriate Microsoft OS 
license for Windows 10. All required Rockwell Automation software is pre-installed but not activated.

OWS 9528-OWSVTENM USB device contains the virtual image template for the OWS. The end use is responsible for acquiring the appropriate Microsoft OS 
license for Windows 10. All required Rockwell Automation software is pre-installed but not activated.

AppServ-OWS, AppServ-EWS 9528-APPXWSENM USB device contains the virtual image template for AppServ-OWS and AppServ-EWS. The end user is responsible for acquiring the 
appropriate Microsoft OS license for Server 2016. All required Rockwell Automation software is pre-installed but not activated. You also 
must purchase the appropriate Windows CAL from a Microsoft distributor.
IMPORTANT: Each client needs an RDS CAL license.

AppServ-Info (Historian) 9528-APPHISENM USB device contains the virtual image template for AppServ-Info (Historian). The end user is responsible for acquiring the appropriate 
Microsoft OS license for Server 2016. All required Rockwell Automation software is pre-installed but not activated.

AppServ-Asset 9528-APPASMENM USB device contains the virtual image template for AppServ-Asset. The end user is responsible for acquiring the appropriate Microsoft 
OS license for Server 2016. All required Rockwell Automation software is pre-installed but not activated.

AppServ-Info (SQL) 9528-APPSQLENM USB device contains the virtual image template for AppServ-Info (SQL). The end user is responsible for acquiring both the appropriate 
Microsoft OS license for Server 2016 and Microsoft SQL server. 

AppServ-Info (VantagePoint) 9528-APPVTPENM USB device contains the virtual image template for AppServ-Info (VantagePoint). The end user is responsible for acquiring the 
appropriate Microsoft OS license for Server 2016. Most required Rockwell Automation software is pre-installed but not activated. The 
FactoryTalk VantagePoint software is not pre-installed for your convenience. For details, see the PlantPAx Virtualization User Manual, 
publication 9528-UM001.

AppServ-Batch 9528-APPBATENM USB device contains the virtual image template for AppServ-Batch. The end user is responsible for acquiring the appropriate Microsoft 
OS license for Server 2016. Most required Rockwell Automation software is pre-installed but not activated. The FactoryTalk Batch 
software is not pre-installed.

Domain controller 9528-PADCVTENM USB device contains the virtual image template for a Domain controller. The end user is responsible for acquiring the appropriate 
Microsoft OS license for Server 2016. You also must purchase the appropriate Windows CAL from a Microsoft distributor.

Table 2 - Installation File on USB Devices

System Element Cat. No. Description

PASS - C (Consolidated) 9528-PASSCENM USB device contains a bootable image to install a consolidated PASS on a physical machine. The consolidated PASS 
includes Historian, VantagePoint, Asset Management, OWS, and EWS. The end user is responsible for acquiring the 
appropriate Microsoft OS license for Server 2016. A Rockwell Automation license is required for software activation.

OWS ISO 9528-OWSISOENM USB device contains a bootable image to install an operator workstation on a physical machine. The end user is 
responsible for acquiring the appropriate Microsoft OS license for the Windows 10 operating system. A Rockwell 
Automation license is required for software activation.
10 Rockwell Automation Publication 9528-UM001G-EN-P - June 2019
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Preface
Build Details Table 3 lists the system build details for each PlantPAx virtual image template.

Table 3 - System and Software Requirements

Element Category Description

Process Automation 
System Server (PASS)

Operating system Microsoft® Windows Server 2016 Standard 

Rockwell Automation® software • FactoryTalk® Services Platform
– FactoryTalk Services platform software, version 6.11.00
– FactoryTalk Activation Manager software, version 4.03.03
– FactoryTalk Linx software, version 6.11.00

• FactoryTalk View Site Edition Client software, version 11.00.00
• FactoryTalk View Site Edition Server software, version 11.00.00
• FactoryTalk View Studio Enterprise software, version 11.00.00
• FactoryTalk Alarm and Event software, version 6.11.00
• FactoryTalk Diagnostics software, version 6.11.00
• FactoryTalk Historian SE Live Data Interface, version 6.00.00
• Rockwell Automation ® Windows Firewall Configuration Utility, version 1.00.12

Engineering 
Workstation (EWS)

Operating system Microsoft Windows 10

Rockwell Automation software • FactoryTalk Services Platform 
– FactoryTalk Services Platform software, version 6.11.00
– FactoryTalk Linx software, version 6.11.00
– RSLinx® Classic software, version 4.11.00
– FactoryTalk Activation Manager software, version 4.03.03

• FactoryTalk View Site Edition Client software, version 11.00.00
• FactoryTalk View Site Edition Server software, version 11.00.00
• FactoryTalk View Studio Enterprise software, version 11.00.00
• FactoryTalk Alarm and Event software, version 6.11.00
• FactoryTalk Diagnostics software, version 6.11.00
• RSLogix 5000® Professional software, versions 20.05.00
• Studio 5000 Logix Designer ® application, versions 31.01.00, 24.02.00
• Studio 5000 Architect Software, version 4.00.00
• RSNetWorx™

– RSNetWorx for EtherNet/IP™ software, version 28.00.00
– RSNetWorx for ControlNet® software, version 28.00.00
– RSNetWorx for DeviceNet® software, version 28.00.00

• FactoryTalk AssetCentre
– FactoryTalk AssetCentre Client software, version 9.00.00

• FactoryTalk Historian SE Management Tools, version 6.00.00
• Studio 5000® Logix Emulate™, version 31.01.00
• ControlFLASH Plus™ software, version 2.00.00
• ControlFLASH software, version 15.01.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.12

Additional third-party software • LOOP-PRO TUNER (Rockwell Automation Edition) software, version 1.9
• Microsoft SQL Server 2012 SP4 Management Tools
• Microsoft SQL Server 2012 SP4 Client Connectivity

Operator Workstation 
(OWS)

Operating system Microsoft Windows 10 

Rockwell Automation software • FactoryTalk Services Platform 
– FactoryTalk Services Platform software, version 6.11.00
– FactoryTalk Linx software, version 6.11.00
– RSLinx Classic software, version 4.11.00
– FactoryTalk Activation Manager software, version 4.03.03

• FactoryTalk Diagnostics software, version 6.11.00
• FactoryTalk View Site Edition Client software, version 11.00.00
• FactoryTalk Alarm and Event software, version 6.11.00
• FactoryTalk AssetCentre Client software, version 9.00.000
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.12

Process Automation 
Domain Controller 
(PADC)

Operating system Microsoft Windows Server 2016 Standard
Rockwell Automation Publication 9528-UM001G-EN-P - June 2019 11



Preface
Application Server 
OWS (AppServ-OWS)

Operating system Microsoft Windows Server 2016 Standard

Rockwell Automation software • FactoryTalk Services Platform
– FactoryTalk Services Platform software, version 6.11.00
– FactoryTalk Linx software, version 6.11.00
– RSLinx Classic software, version 4.11.00
– FactoryTalk Activation Manager software, version 4.03.03

• FactoryTalk View Site Edition Client software, version 11.00.00
• FactoryTalk Diagnostics software, version 6.11.00
• FactoryTalk Alarm and Event software, version 6.11.00
• FactoryTalk AssetCentre Client software, version 9.00.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.12

Application Server EWS 
(AppServ-EWS)

Operating system Microsoft Windows Server 2016 Standard

Rockwell Automation software • FactoryTalk Services Platform 
– FactoryTalk Services Platform software, version 6.11.00
– FactoryTalk Linx software, version 6.11.00
– RSLinx® Classic software, version 4.11.00
– FactoryTalk Activation Manager software, version 4.03.03

• FactoryTalk View Site Edition Client software, version 11.00.00
• FactoryTalk View Site Edition Server software, version 11.00.00
• FactoryTalk View Studio Enterprise software, version 11.00.00
• FactoryTalk Alarm and Event software, version 6.11.00
• FactoryTalk Diagnostics software, version 6.11.00
• RSLogix 5000® Professional software, versions 20.05.00
• Studio 5000 Logix Designer ® application, versions 31.01.00, 24.02.00
• Studio 5000 Architect Software, version 4.00.00
• RSNetWorx™

– RSNetWorx for EtherNet/IP software, version 28.00.00
– RSNetWorx for ControlNet software, version 28.00.00
– RSNetWorx for DeviceNet software, version 28.00.00

• FactoryTalk AssetCentre
– FactoryTalk AssetCentre Client software, version 9.00.00

• FactoryTalk Historian SE Management Tools, version 6.00.00
• Studio 5000® Logix Emulate™, version 31.01.00
• ControlFLASH Plus™ software, version 2.00.00
• ControlFLASH software, version 15.01.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.12

Additional third-party software • LOOP-PRO TUNER (Rockwell Automation Edition) software, version 1.9
• Microsoft SQL Server 2012 SP4 Management Tools
• Microsoft SQL Server 2012 SP4 Client Connectivity

Application Server 
Historian (AppServ-
Info Historian)

Operating system Microsoft Windows Server 2016 Standard 

Rockwell Automation software • FactoryTalk ®Services Platform
– FactoryTalk Services Platform software, version 3.00.00
– FactoryTalk Activation Manager software, version 4.02.00
– FactoryTalk Diagnostics software, version 3.00.00

• FactoryTalk Alarm and Event software, version 3.00.00
• FactoryTalk Historian Site Edition Server, version 6.00.00
• FactoryTalk Historian ActiveView software, version 3.20.03
• FactoryTalk Historian DataLink software, version 4.20.02
• FactoryTalk Historian Management software, version 6.00.00
• FactoryTalk Historian ProcessBook software, version 3.20.03
• FactoryTalk Historian SE Live Data Interface, version 6.00.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.10
• FactoryTalk Linx software , version 6.00.00

Table 3 - System and Software Requirements

Element Category Description
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Application Server 
Asset Management 
(AppServ-Asset)

Operating system Microsoft Windows Server 2016 Standard 

Rockwell Automation software • FactoryTalk Services Platform
– FactoryTalk Services Platform software, version 6.11.00
– FactoryTalk Diagnostics software, version 6.11.00
– FactoryTalk Linx software, version 6.11.00
– RSLinx Classic software, version 4.11.00
– FactoryTalk Activation Manager software, version 4.03.03
– FactoryTalk Alarm and Event software, version 6.11.00

• FactoryTalk AssetCentre
– FactoryTalk AssetCentre Server software, version 9.00.00
– FactoryTalk Asset Centre Client software, version 9.00.00

• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.12

Additional third-party software • Microsoft SQL Server Express 2012 SP4 Advanced (includes Management Studio)

Application Server 
Information SQL 
(AppServ-Info-SQL)

Operating system Microsoft Windows Server 2016 Standard

Microsoft software • Microsoft SQL Server Standard 2012 SP4 (includes Management Studio)

Application Server 
Information 
VantagePoint® 
(AppServ-Info-
VantagePoint)

Operating system Microsoft Windows Server 2016 Standard

Rockwell Automation software • FactoryTalk Services Platform
– FactoryTalk Services Platform software, version 3.00.00
– FactoryTalk Activation Manager software, version 4.02.00
– FactoryTalk Diagnostics software, version 3.00.00
– FactoryTalk Linx software, version 6.00.00

• FactoryTalk VantagePointSystem Server software, version 8.10.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.10

Application Server 
Batch Management 
(AppServ-Batch)

Operating system Microsoft Windows Server 2016 Standard

Rockwell Automation software • FactoryTalk Services Platform
– FactoryTalk Activation Manager software, version 4.02.00
– FactoryTalk Diagnostics software, version 3.00.00
– FactoryTalk Services Platform software, version 3.00.00
– RSLinx Classic software, version 3.81.00

• FactoryTalk Batch, version 13.00.02
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.10

Table 3 - System and Software Requirements

Element Category Description
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Table 4 lists the system build details for PlantPAx USB devices.
Table 4 - Build Details for USB Devices

Element Category Description

PASS-C (consolidated) Operating system Microsoft Windows Server 2016 Standard

Rockwell Automation software • FactoryTalk Services Platform
– FactoryTalk Services platform software, version 6.11.00
– FactoryTalk Activation manager software, version 4.03.03
– FactoryTalk Linx software, version 6.11.00
– RSLinx Classic software, version 4.11.00

• FactoryTalk View Site Edition Client software, version 11.00.00
• FactoryTalk View Site Edition Server software, version 11.00.00
• FactoryTalk View Studio Enterprise software, version 11.00.00
• FactoryTalk Alarm and Event software, version 6.11.00
• FactoryTalk Diagnostics software, version 6.11.00
• FactoryTalk Historian SE Live Data Interface, version 6.00.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.12
• FactoryTalk Historian SE software, version 6.00.00
• FactoryTalk AssetCentre Server, version 9.00.00
• FactoryTalk AssetCentre Client, version 9.00.00
• Studio 5000 Logix Designer®, version 31.01.00
• Studio 5000 Logix Designer, version 24.02.00
• RSLogix 5000, version 20.05.00
• VantagePoint® System Server, version 8.10.00
• ControlFLASH software, version 15.01.00
• ControlFLASH Plus software, version 2.00.00

Additional software Microsoft SQL Server Express 2012 SP4 Advanced (includes Management Studio)

Operator Workstation 
(OWS ISO)

Operating system Microsoft Windows 10

Rockwell Automation software • FactoryTalk Services Platform
– FactoryTalk Services platform software, version 6.11.00
– FactoryTalk Linx software, version 6.11.00
– RSLinx Classic software, version 4.11.00
– FactoryTalk Activation manager software, version 4.03.03

• FactoryTalk Diagnostics software, version 6.11.00
• FactoryTalk View Site Edition Client software, version 11.00.00
• FactoryTalk Alarm and Event software, version 6.11.00
• FactoryTalk AssetCentre Client, version 9.00.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.12
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Additional Resources These documents contain information about related products from 
Rockwell Automation that can provide additional guidance when deploying 
the virtual image templates.

You can view or download publications at
http://www.rockwellautomation.com/global/literature-library/overview.page. 
To order paper copies of technical documentation, contact your local Allen-
Bradley distributor or Rockwell Automation sales representative.

Resource Description

PlantPAx Distributed Control System Reference Manual, 
publication PROCES-RM001

Details the application rules for implementing a 
PlantPAx system.

PlantPAx Distributed Control System Selection Guide, 
publication PROCES-SG001

Provides procurement information for a
PlantPAx system.

Product Certifications website, http://www.ab.com Provides declarations of conformity, certificates, and 
other certification details.

FactoryTalk Historian SE Installation and Configuration 
Guide, publication HSE-IN025

Provides information on how to install, secure, 
configure, use, and troubleshoot 
FactoryTalk Historian SE.

PlantPAx Distributed Control System Infrastructure 
Configuration, publication PROCES-UM001

Provides screen facsimiles and step-by-step 
procedures to configure infrastructure components for 
your system requirements.

PlantPAx Distributed Control System Application 
Configuration, publication PROCES-UM003

Provides the steps necessary to start development of 
your PlantPAx Distributed Control System.

Knowledgebase Answer ID 32715 - Cannot add/change 
pens in trend from SE client on Terminal Server at 
https://rockwellautomation.custhelp.com/app/answers/
detail/a_id/32715
You must have a TechConnectSM license to view this 
document.

Provides details about the problem of adding/
changing pens in trend from SE client on Terminal 
Services.

Knowledgebase Answer ID 496679 - FAQ: FactoryTalk 
Historian SE: MDB to AF Preparation Wizard at 
https://rockwellautomation.custhelp.com/app/answers/
detail/a_id/496679 
You must have a TechConnect? license to view this 
document.

Provides information on how to use the FactoryTalk 
Historian SE MDB to AF Preparation wizard.

Knowledgebase Answer ID 567658 - Using FactoryTalk 
View SE with Windows 2008 R2 Remote Desktop Services - 
Getting Started white paper at 
https://rockwellautomation.custhelp.com/app/answers/
detail/a_id/567658
You must have a TechConnect license to view this 
document.

Provides information on how to use FactoryTalk View 
SE with Microsoft Windows 2008 R2 Remote Desktop 
Services.

Knowledgebase Answer ID 60585 - FactoryTalk Historian 
SE Collective Manager Error - Error Writing Server at
https://rockwellautomation.custhelp.com/app/answers/
detail/a_id/60585 
You must have a TechConnect license to view this 
document.

Provides information on how to implement a 
collective for FactoryTalk SE Historian.
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Chapter 1

Basics of Virtualization

 

Overview Rockwell Automation offers virtual image templates as an option to deploy a 
virtualized PlantPAx® system. The PlantPAx Virtual Image Templates deliver all 
system elements as pre-configured, drop-in virtual machines. The industry also 
refers to virtualized system elements as virtual appliances. However, in this 
manual, virtual system elements are referred to as virtual image templates because 
you can use them to deploy as many virtual appliances as you want.

The virtual image templates are 
delivered as an Open Virtual 
Appliance (OVA) file on USB 
devices or via the Web. With 
OVA files, you can use any 
virtualization platform for 
deployment. The guidelines that 
are contained in this manual are 
for setup and deployment of the 
templates in a VMware vSphere 
environment.

The virtual image templates help to reduce validation costs and initial 
engineering time, enhance scalability, simplify upgrades, and patch management. 
Only one copy of the virtual image templates is needed for a project. 

Some of the benefits of a virtualized PlantPAx system include the following:
• Increased energy savings
• Extended system life
• Reduced system footprint and hardware cost
• Increased up time and availability
• Self-contained simulation and engineering
• Faster server provisioning
• Improved disaster recovery

Flexibility and ease of deployment are key when designing a virtual infrastructure. 
Both intangibles are a part of the PlantPAx system. 

Virtual Machines

Hypervisor

Host

vSphere Web Client
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Chapter 1 Basics of Virtualization
Figure 1 contains the topics that are described in this chapter. See the page 
number or click the links for quick access to specific information.

Figure 1 - Basic Virtualization Workflow

Start

Download a Hypervisor

See page 19

Virtual Template Overview

See page 17

Install a Hypervisor

See page 20

Using a vSphere Web Client

See page 26

See Chapter 2 Deploy the PlantPAx Virtual Image Templates
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Download a Hypervisor 

This chapter describes how to install a hypervisor. A hypervisor is a software 
program that manages the host physical server and allocates resources to each 
virtual machine that runs in the host. Multiple virtual machines can share one 
physical host. However, each virtual machine has its own memory, storage, and 
CPU allocation on the host. 

Complete these steps.

1. To download the files, go to the VMware website 
at http://www. vmware.com.

2. From the main menu, click Downloads and select vSphere Hypervisor in 
the Free Product Downloads pane.

A Download Center login page for the vSphere Hypervisor appears. 

3. Do one of the following:
• For an existing account, type an email address or customer number, a 

password, and click 'Log in'.
• For a new account, Type your first name, last name, and Email Address.

Click Continue and follow the prompts to register.

After creating your free account, in an email from VMware, there is a 
link to verify that your information is correct. When you click this link, 
your browser navigates to the VMware website and asks you to enter 
your recently created user name and password. 

4. Click Log in.

IMPORTANT The following procedures apply only to virtual templates. Skip to Chapter 6 if 
you are deploying a PASS-C or OWS ISO

TIP We are using VMware vSphere as an example, you can use other hypervisors 
for this procedure.
Rockwell Automation Publication 9528-UM001G-EN-P - June 2019 19

http://www.vmware.com/


Chapter 1 Basics of Virtualization
The Downloads Packages page appears.

5. Download the WMware vSphere Hypervisor. 

Install a Hypervisor This section describes how to install the VMware vSphere hypervisor to a host 
server. The hypervisor, which is also known as ESXi, is used to manage the 
resources of your server to enable deployment of virtual images. To install the 
hypervisor on your server, we recommend that you copy the installer image (.iso) 
to a DVD. If desired, you can also copy the installer image (.iso) to a USB drive 
(at least 1 GB).

Copy Installer Image to DVD

Complete these steps to copy the hypervisor installer image (.iso) to a DVD.

IMPORTANT For a production environment, we recommend a minimum of a 
VMware vSphere Essentials Kit. The vSphere Essentials Kit provides 
access to key virtual components. For more information, contact your 
Allen-Bradley distributor. 

TIP We are using VMware vSphere Hypervisor as an example, but you can use 
other hypervisors with this procedure.
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1. Right-click the downloaded installer image and choose Burn disk image.

2. Select the DVD drive to write the data, and click Burn.

3. When the DVD is completed, click Close.

Copy Installer Image to USB Drive

Complete these steps to copy the hypervisor installer image (.iso) to a USB drive.

1. Right-click the downloaded installer image and choose copy.

2. Select a location on the USB drive, right-click, and choose paste.

3. When the file copy is completed, you can remove the USB drive.

IMPORTANT Before starting this procedure, make sure that the USB drive has enough space 
on it to hold the 'ISO' file.
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Use a DVD or USB Drive to Start Server

When you start the server, make sure to choose the DVD or USB drive that 
contains the installer image as the booting address. Complete these steps to install 
the ESXi (hypervisor).

1. Insert the DVD or USB drive into the host physical server.

2. Choose the optional booting address during the server startup.

3. Press Enter to continue'.

4. On the End User License Agreement (EULA) page, read the EULA, and 
press F11 to accept the terms of the EULA and continue.

5. Select the disk to install the vSphere Hypervisor and press Enter 
to continue.
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6. Select the desired keyboard and press Enter to continue.

7. Type a root password, retype the password, and press Enter to continue.

A message appears when the system scans for information. This scan can 
take a few minutes.

8. Press F11 to Install.

The Installation Complete dialog box appears.

9. Remove the DVD or USB device and press Enter to shut down and restart.

The server shutdown and restart can take a few minutes.

TIP Remember this password; you use it again in future steps.
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Assign an IP Address to the Host

You must assign an IP address to the host so that it is on the desired network and 
can communicate with the client workstations. For example, you can deploy a 
virtual image template in this server remotely from another workstation on the 
same network.

Complete these steps.

1. After the system restarts, press F2 to Customize System/View Logs.

2. Type the Login name and password.

Use the Login name and password that you created in step 7 on page 23.

3. Press Enter to OK.

The System Customization page appears.

TIP For the screens in this section, use the arrow keys on your keyboard to move 
between the fields on the pages.
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4. Use the arrow keys to move to 'Configure Management: Network' and 
press Enter.

The Configure Management Network page appears.

5. Move to 'IPv4 Configuration' and press Enter to change.

The IPv4 Configuration page appears.

6. Move to 'Set static IP Address and network configuration' and press the 
Space bar.

The presence of a small circle between the parentheses indicates that this 
option is selected.

7. In turn, move to the IP address, Subnet Mask, and default gateway address 
and type the appropriate values for your system and organization.

8. After you have typed the addresses, press <Enter> to OK.

9. On the Configuration Management Network page, press <Esc> to Exit.
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A message appears to confirm that you want to change the management 
network of the host.

10. Press 'Y' for Yes.

11. On the System Customization screen, press <Esc> to log out.

You have assigned an IP address to the host server.

Using a vSphere Web Client After the ESXi (hypervisor) is installed, the simplest way to connect directly to 
one host server is with a vSphere Web Client. If you have multiple ESXi hosts, we 
recommend that you configure a vCenter Server that offers additional 
functionality. Through the vSphere Web Client, you can add, delete, and manage 
the virtual machines on your infrastructure. 

This section explains how to activate your vSphere license. The vSphere Web 
Client resides on a computer that is being used to connect to the server where the 
virtual templates are deployed. You can use any web browser with these steps. A 
Firefox browser is shown with our examples.

To use a vSphere Web Client, for the first time, complete these steps.

1. Open a web browser and type the IP address that you created for the
hypervisor host.

Use the IP address that you entered for step 7 on page 25.

TIP This section describes how to use a web browser for vSphere software, version 
6.0 or later. The following steps are similar for the vSphere Client application, 
which you use to interface ESXi 6.0 or earlier. 
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A security warning appears the first time that you connect to the ESXi
host server.

2. Click Advanced.

The security warning expands with an invalid certificate message.

3. Click Add Exception.
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The Add Security Exception dialog box appears. 

4. To ignore the warning, click Confirm Security Exception.

Contact your IT department if you want a security certificate for your 
ESXi host server.

The VMware ESXi Host login dialog box appears. 

5. Type the user name and password that you created in step 7 on page 23.

6. Click Log in.
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The ESXi Web Client window appears.

7. To open the Navigator, click the Navigator button.

The Navigator Window opens in the left pane.

8. Click Manage.

9. Click the Licensing tab, then choose Assign license under Actions.

10. Type your license key and click Check license.
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11. When the license is validated, click Assign license.

Features that are associated with the license key appear.

Proceed to Chapter 2 for instructions on how to deploy PlantPAx virtual 
image templates to create virtual machines within your system.
30 Rockwell Automation Publication 9528-UM001G-EN-P - June 2019



Chapter 2

Deploy the PlantPAx Virtual Image Templates

Distributed control systems are composed of several industry-accepted system 
elements. Virtual Image Templates are virtualized system elements, which 
contain the software and tools that comprise a specific system element. The 
templates are a framework to deploy the necessary system elements for a 
PlantPAx® system in a virtual environment conveniently and consistently.

This chapter describes different types of deployments for Virtual Image 
Templates. A template is a master copy of a virtual machine. Once deployed, the 
templates provide pre-configured settings for each virtual machine. 

A virtual machine acts independently and has its own resource allocation from 
the host. You interact with virtual machines as if they are on a dedicated 
workstation with their own physical resources.
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Figure 2 contains the topics that are described in this chapter. See the page 
number or click the links for quick access to specific information.

Figure 2 - Virtual Template Deployment Workflow

Start

First Time Template Deployment
See page 33

Create Your Own Template
See page 43

Deploy Additional Virtual Images 
From a Local Template - See page 64

Convert a Virtual Image
See page 69

Optional VM Interactions
See page 77

Enter a Windows License
See page 201

See 
Chapter 3
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Deploy a Virtual Image 
Template for the First Time

This section describes how to deploy a virtual image for the first time. The virtual 
image can be deployed from the USB drive that is shipped or from a storage 
location on a workstation. This workstation is the computer that you are using to 
connect to the server you plan to use as the host server. The deployment 
procedure is applicable to all PlantPAx virtual templates. 

This procedure must be followed every time a virtual image template is deployed 
for the first time into your system. 

To deploy a virtual image template for the first time, complete these steps.

1. Open a web browser and type the IP address that you created for the
host server.

2. Type the user name and password for the EXSi host, and click Log in.

IMPORTANT If you plan to deploy a domain controller, it is recommended that the domain 
controller is the first element that is deployed in the system. The PADC 
template facilitates future activities, such as creating your own virtual image 
templates and deploying virtual images to your system at your convenience.

TIP Before deploying a virtual image from a virtual image template, we advise you 
to copy the virtual image template to your local hard disk drive. Copy the 
template to save time during the deployment process.
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3. In the Navigator pane, click Virtual Machines and choose
Create/Register VM.

4. Click ‘Deploy a virtual machine from an OVF or OVA file’ and click Next.
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5. Type a name for the virtual machine.
Click in the shaded area and select the .ova file to be used and click Next.

The virtual file displays with the name.

6. Select the datastore for your configuration and disk files storage.

7. Click Next.

IMPORTANT There are two main formats for storing virtual images: OVF (open 
virtual format) and OVA (open virtual appliance). Our templates are for 
appliances, which are self-contained virtual system elements. VMware 
software labels the wizard ‘OVF Template’ but ignore because your 
PlantPAx Virtual Image Templates in the OVA format are suitable for 
this procedure.
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8. Use defaults for network mapping and disk provisioning, and click ‘Power 
on automatically.’

9. Click Next.

10. Click Finish.
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The virtual template uploads.

The Result column shows ‘Completed successfully’ when the template 
upload finishes.

The completion percentage of the upload 
is shown at the bottom of the dialog box.
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Power Up the Virtual Machine

To power up a virtual image template for the first time, complete these steps.

1. Open a web browser and type the IP address that you created for the
host server.

2. Type the user name and password for the local host, and click Log in.

3. Right-click the Virtual Machine and choose Power>Power on.

TIP Before powering up a virtual machine, consider creating a template of it for 
future deployments.
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After powering up the virtual machine, do the following:
• If you are deploying a virtual workstation, see Workstation Common 

Configuration on page 151
• If you are deploying a virtual server, see Configure Microsoft Windows 

Server on page 88

Install VMware Tools

The VMware vSphere Client software has better graphic performance with the 
VMware Tools SVGA driver installed. The VMware Tools package also supports 
required shared folders and drag-and-drop features.

Other tools in the package support synchronization of time in the guest 
operating system, copy and paste between guest and host, and improved mouse 
performance in some guest operating systems.

Complete these steps to install or upgrade VMware tools on the VMware
Virtual Machine.

1. Open a web browser and type the IP address that you created for the
host server.

2. Type the user name and password for the local host, and click Log in.

The VMware ESXi window appears.

3. From the Navigator in the left pane, right-click the virtual machine in 
which you want to update or install VMware Tools.

IMPORTANT When powering up the virtual machine for the first time, the screen can remain 
black for several minutes.

IMPORTANT Images that are shown in this section are VMware vSphere software,
version 6.5.
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4. Click Guest OS and choose Install VMware Tools.

5. Open Windows Explorer on the virtual machine image that you want to 
install VMware Tools.

6. Click ‘This PC’ to view the tools to install on Drive D.

7. Double-click the DVD drive to initiate the install.

IMPORTANT The guest OS of the virtual machine must be running.
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8. When the VMware Tools Setup Welcome window appears, click Next
to continue.

9. On the setup screen, click Complete and then click Next to continue.
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10. To start the installation process, click Install.

11. When the VMware Tools Setup popup window appears, click Finish.

12. To restart your virtual image and complete the VMware Tools Install 
Process, click Yes.
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Create a Template for Future 
Virtual Machine 
Deployments

This section shows how to create a template within a datacenter by using a 
previously deployed virtual image. A virtual machine is cloned, and the clone 
becomes a template. This template can be used to deploy other images. You can 
store the original template for safekeeping in case you modify your templates.

Create a vCenter Server

Before cloning the virtual image, configure a vCenter server. A vCenter server 
provides centralized management of virtualized hosts and virtual machines from 
one console. It gives administrators visibility into the configuration of the critical 
components of a virtual infrastructure—all from one place.

On the workstation you use to manage your virtual appliances (templates and 
machines), complete these steps.

1. On the VMware website, download the vCenter Server Appliance 6.5 
software and mount the .iso image.

IMPORTANT A datacenter is the primary container of inventory objects such as hosts and 
virtual machines. From the datacenter, you can add and organize inventory 
objects. Typically you add hosts, folders, and clusters to a datacenter.
A vCenter server can contain multiple datacenters. Larger organizations can 
use multiple datacenters to represent organizational units in their enterprise. 
Inventory objects can interact within datacenters, but interaction across 
datacenters is limited. For example, you can move a virtual machine with 
vMotion technology across hosts within a datacenter but not to a host in 
another datacenter.

IMPORTANT The workstation that you use to connect to and configure your host server can 
act as your vCenter server. 

TIP The steps to download the vCenter server software are similar to the 
steps used to download Hypervisor, see Download a Hypervisor on 
page 19.
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2. Start the vCenter Server Appliance 6.5 installer. Choose vCenter Server 
6.5 appliance>vcsa-ui-installer>win32>installer.exe.
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3. To install a new vCenter Server Appliance, click Install.

4. Click Deploy Appliance for Stage 1 and then click Next.
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5. Check I accept the terms of the license agreement and then click Next. 

6. Click vCenter Server with an Embedded Platform Services Controller and 
then click Next.
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7. Enter the ESXi host information of the location where the vCenter server 
appliance is deployed, and enter the host credentials. Click Next
to continue.

8. Click Yes to accept the Certificate Warning.
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9. Enter the name for the appliance and set the root password. Click Next to 
continue.

10. Select the deployment size for your environment. Click Next to continue.
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11. Select the datastore where the VCSA appliance will be stored. Click Next 
to continue.

12. Configure the networking for the VCSA appliance. Click Next to 
continue. 

IMPORTANT Put the IP address that is used in both the DNS forward and reverse lookup 
zones.
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13. Verify that the configuration is correct on the summary dialog box and 
then click Finish.
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14. Click Continue to proceed to the stage two setup process.

15. From the Stage 2 introduction dialog box, click Next.
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16. Select the Time synchronization mode and enable SSH access.

17. Click Next.

18. Configure Single Sign On (SSO) by typing a domain name, password and 
site name. Click Next to continue.
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19. Check to participate in the Customer Experience Improvement Program 
(CEIP) if interested, click Next to continue.

20. Verify that the configuration is correct on the summary dialog box and 
then click Finish.
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Create a Template from an Existing Virtual Image

This procedure shows you how to make a copy of a virtual image and turn it into 
a template for future deployments. 

1. In a Web Browser, enter the IP address of the computer where your 
vCenter Server is installed.

2. Click vSphere Web Client (Flash).

TIP Consider this process when you back up virtual images.

IMPORTANT The images that are shown in this section are VMware vSphere Client software, 
version 6.5.
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3. Enter the Username and Password. Use the User name and password that 
you created for the vCenter Server in step 18 on page 52. Click Login.

IMPORTANT The user name consists of the vCenter Single Sign-On user name plus '@' plus 
the Domain name.
In our example, the user name is 'administrator@system.plantpax.local'.
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Create a Datacenter

The Datacenter is the primary container of inventory objects such as hosts and 
virtual machines. 

1. From The VMware vSphere Web Client dialog box, highlight your 
vCenter Server, and click 'Create Datacenter'. 

2. When prompted, type a name for the new datacenter (‘New Datacenter’ in 
our example) and click OK.
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Add a Host

The host is the virtual machine where the virtual image is deployed.

1. The New Datacenter is added under the vCenter Server. Highlight the 
New Datacenter and click 'Add a Host' to add a host server.

2. The 'Add Host' window appears. In the Name and location step, type the 
host IP address, and click 'Next'. See step 7 on page 47.

3. In the 'Connection Settings' step, type the User name and Password. The 
Username and Password were created in step 7 on page 47. Click 'Next'. 
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4. Verify that the settings are correct on the Host summary dialog box and 
then click Next.

5. Assign a License.
a. If using the trial license that came with the VMware vSphere 

Hypervisor, click the default Evaluation License and click next.

b. If you have purchased a permanent license, Click the (Plus Sign) to 
assign a new license key to this host. Type in the license key. Click Next, 
then click Finish.
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6. In the Lockdown mode step, click Disabled, and click Next.

7. In the VM location step, select the Datacenter that you created, and click 
Next.

IMPORTANT Because a vCenter server can manage multiple host servers, make sure to 
create/select the proper datacenter and host server where the virtual machines 
reside.
These organizational features help improve your understanding of your 
infrastructure and help with the management of servers.
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8. Verify that the configuration is correct in the Ready to complete dialog box 
and then click Finish.

9. The Host is added under the datacenter. The Navigator section of the 
vSphere Web Client window now includes the vCenter server 
(VRTXvCenter), the Datacenter (New Datacenter), and the Host 
(172.18.1.13) as shown in the following image.
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Clone the Image to Template

1. Right-click the virtual image that you want to clone and choose 
Clone>Clone to Template.

2. Type a name for the new template, select a location, and click Next.
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3. Select a host location to store the new template and click Next.

4. Select the disk format, storage policy, and the hypervisor that manages the 
resources of the server that hosts this template. See Table 5 for disk format 
options. Click Next. 

Table 5 - Disk Format Options

Format Description

Same format as source Use the same format as the original disks.

Thick Provision Lazy Zeroed Disk storage is allocated immediately in a default thick format. Blocks 
containing older data on the storage device are cleared only when the 
virtual machine writes new data to the disk for the first time.

Thick Provision Eager Zeroed Disk storage is allocated immediately in a default thick format where blocks 
on the physical storage device are formatted with zeros to overwrite any 
older data.

Thin Provision Disk storage is allocated on demand as data is written to virtual disks.
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5. Verify that the configuration is correct on the Ready to Complete dialog 
box.
• If the information is incorrect, click Back to correct the information.
• If the information is correct, click Finish. 

IMPORTANT The process of cloning a virtual machine to a template can take up to 30 
minutes. This time is largely dependent on the size of the hard disk drive of the 
virtual machine you are making a template from.
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Deploy Additional Virtual 
Images From a Local 
Template 

When you have virtual image templates loaded into your datacenter, you can 
deploy any number of virtual images from those templates. Additional 
deployments can be performed from these new templates. 

Complete these steps to deploy additional virtual images.

1. In a Web Browser, enter the IP address of the computer where your 
vCenter Server is installed.

2. Click vSphere Web Client (Flash).
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3. Enter the Username and Password. Use the User name and password that 
you created for the vCenter Server in step 18 on page 52. Click Login.

IMPORTANT The user name consists of the vCenter Single Sign-On user name plus '@' plus 
the Domain name.
In our example, the user name is 'administrator@system.plantpax.local'.
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4. From the left side of the vSphere Web Client window, highlight your 
vCenter Server, then select the 'VMs' tab.

5. Select the 'VM Templates in Folders' tab, then right-click the template that 
you plan to deploy to a New Virtual Image.

6. Select 'New VM from This Template'.

7. In the Name box, type a name for the virtual machine.

8. In the Inventory Location box, select a location to store the new virtual 
machine and click Next.
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9. The 'Select storage' step appears.
• In the 'Select virtual disk format' box, select "Thin Provision'. 
• In the 'VM storage policy" box, select 'Datastore Default'.
• Select the Datastore to host the cloned template. 
• Click Next.

Table 6 - Disk Format Description

Format Description

Same format as source Use the same format as the original disks.

Thick Provision Lazy Zeroed Disk storage is allocated immediately in a default thick format. Blocks 
containing older data on the storage device are cleared only when the 
virtual machine writes new data to the disk for the first time.

Thick Provision Eager Zeroed Disk storage is allocated immediately in a default thick format where blocks 
on the physical storage device are formatted with zeros to overwrite any 
older data.

Thin Provision Disk storage is allocated on demand as data is written to
virtual disks.
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10. The 'Select clone options' step appears.
• Clear 'Customize the operating system'. We recommend that no 

Customization is done at this stage.
• Clear 'Customize this virtual machine's hardware (Experimental)'.
• Clear 'Power on virtual machine after creation'. 
• Click Next.

11. The 'Ready to Complete' step appears. Select one of the following to verify 
settings:
• If there is incorrect information, click Back to correct the information.
• If the information is correct, click Finish.

12. You can view the status of the task by finding 'Clone virtual machine' in 
Recent Tasks at the bottom of the window. When the status = Completed, 
the cloning is finished. 

IMPORTANT When you clone a virtual machine or deploy a virtual machine from a 
template, you can customize the guest operating system of the virtual 
machine. Customizing guest operating systems can help prevent 
conflicts if virtual machines with identical settings are deployed.
You can specify the customization settings when you launch the Guest 
Customization wizard during the cloning or deployment process

IMPORTANT The process of deploying a virtual machine from a template can take up to 30 
minutes. The time that is required is largely dependent on the size of the hard 
disk drive of the template you are using to deploy a virtual machine.
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Convert a Virtual Image This section describes how to use the vCenter Converter Standalone tool as an 
alternative to deploy a virtual machine into your host server. The tool is not 
required for this procedure but it is a free tool that lets you deploy virtual 
machines into your host server. 

The vCenter Converter Standalone tool has important capabilities such as 
converting physical machines, virtual machines, and system images. These 
capabilities are used in VMware hosted and managed products, which are key for 
system migrations or upgrades.

You can use vCenter Converter Standalone software to perform important 
conversion tasks, including the following:

• Import running remote physical and virtual machines as virtual machines 
to a simple host server with ESXi hypervisor or to a host server with ESXi 
managed by a vCenter server.

• Import virtual machines that are hosted by VMware Workstation or 
Microsoft Hyper-V server to a host server with ESXi managed by a 
vCenter server.

• Import third-party backup or disk images to a host server with ESXi 
managed by a vCenter server.

Download the vCenter Converter Standalone Software

On the VMware website, download the vCenter Converter Standalone software.

TIP The steps to download the vCenter Converter Standalone software
are similar to the steps used to download Hypervisor, see Download a 
Hypervisor on page 19.
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Install the Converter Standalone Software

If you do not own a copy of VMware Workstation or vSphere Client and you 
wish to deploy a virtual machine into your host server, you must install the 
vCenter Converter Standalone software. Install the software on the workstation 
you use to connect to and configure your host server. If you intend to use vCenter 
Converter Standalone software to create a virtual image of a physical computer, 
you must install the tool on the machine that you are virtualizing. For more 
information on how to use the tool for different procedures,
see http://www.vmware.com/products/converter.

To install the software, complete these steps.

1. On the workstation to install the vCenter Converter Standalone tool, 
navigate to the installation files and double-click the VMWare-
converter.exe file.

The vCenter Converter Standalone program opens and starts an Install 
Shield wizard.

2. Click Next.
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3. Click ‘I agree to the terms in the License Agreement’, and click Next.

4. On the Destination Folder page, click Next.

5. On the Setup Type page, select one of the following:
• Local installation (recommended).
• Client-server installation (see http://www.vmware.com/pdf/

convsa_50_guide.pdf for more information.

For simplicity, our example is a local installation.

6. Click Install, select Converter server, and click Next.

7. Click Finish when the installation is complete.
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Convert a Virtual Machine

The vCenter Converter Standalone software installs VMware Tools to let you 
customize the guest operating system. For example, you can change the host name 
or network settings.

To change the host name, complete these steps.

1. Open the VMware vCenter Converter Standalone software and
click Convert Machine.
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The Conversion dialog box appears.

2. Select ‘VMware Workstation or other VMware virtual machine’ from the 
'Select source type' pull-down. 
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3. Click browse to navigate to the location of the virtual image that you want 
to convert, choose the file, and click Next. 

4. On the Destination System window, type the IP address, User name, and 
Password of the server where the virtual machine is being deployed to after 
conversion.

5. Click Next.

6. Click Ignore for now on the certificate window.

Talk to your system manager about SSL certificates for this application.
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7. Type the name that you want for this virtual machine and click Next. 

8. Select the location where you store the virtual machine.

In the Inventory section, you can have multiple suitable hosts depending 
on your system configuration in the Datastore section. More locations to 
store the files for your virtual machine show up depending on your system 
configuration.

9. Select the virtual machine version from the pull-down, and click Next.
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A Conversion window with parameter options for the conversion task 
appears. This window is where you can make permanent changes 
according to your needs. 

10. After making your choices, click Next.

11. Confirm your settings and click Finish.

The vCenter Converter Standalone window appears to show the progress 
of the conversion.
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The conversion time depends on the following:
• Network connection between the host server (where the converted 

machine is hosted) and the workstation (where the machine that you 
are converting currently resides)

• Size of the image

Optional Virtual Machine 
Interactions

To help expedite the use of your virtual machines, consider the following options:
• Initiate Automatic Startup on page 77
• Set Resource Pool Priority on page 83

Initiate Automatic Startup

To program the host server to start your virtual machines automatically, complete 
these steps.

1. In a Web Browser, enter the IP address of the computer where your 
vCenter Server is installed. This IP address was created in step 7 on page 
25.

2. On the Welcome to VMware vSphere screen, click vSphere Web Client 
(Flash).
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3. Enter the Username and Password. Use the User name and password that 
you created for the vCenter Server in step 18 on page 52. Click Login.

IMPORTANT The user name consists of the vCenter Single Sign-On user name plus '@' plus 
the Domain name.
In our example, the user name is 'administrator@system.plantpax.local'.
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4. Select the Host Server, then select the Configure Tab, then select VM 
Startup/Shutdown. On the VM Startup/Shutdown window, click 'Edit'.
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5. Check 'Automatically start and stop virtual machines with the system'. 
Click the (Up Arrow) to move the desired Virtual Machine host server 
from the Manual Startup category up to the Automatic Startup category.

You can select additional images and click the Up Arrow or Down Arrow 
to determine the startup order as shown in the following image. A 
sequential number order appears.

6. When you are satisfied with the Startup order, click OK.
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7. The Virtual Machines are now configured for Automatic Startup as shown 
in the following screen capture.

IMPORTANT Following is the recommended start-up order for the typical system 
elements of a virtual PlantPAx system.
1. Process Automation Domain Controller - PADC
2. SQL server - AppServ-Info (SQL)
3. Process Automation System Server - PASS
4. Engineering Workstation Application Server (AppServ-EWS)
5. Redundant Process Automation System Server - PASS
6. Batch Management Server (AppServ-Batch)
7. Operator Workstation Application Server (AppServ-OWS)
8. Historian server - AppServ-Info (Historian)
9. VantagePoint server - AppServ-Info (VantagePoint)
10. Asset Management server (AppServ-Asset)
11. Level 3 devices and computers
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Send Commands to Host Server

You can also send shutdown and restart commands directly to the host server via 
the vSphere Web Client.

1. On the vSphere Web Client window, right-click a host server and choose 
either Shut Down or Reboot.

2. In the confirmation window, type a reason for the Shut Down or Reboot 
and click OK or Cancel.
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Set Resource Pool Priority

You can set the priority of the resource allocation that your virtual machine 
requires from the host server. The allocation of CPU and memory resources 
depends on performance needs. A virtual machine can be grouped for High 
Performance, Normal Performance, or Low Performance depending on its 
performance needs.

1. In a Web Browser, enter the IP address of the computer where your 
vCenter Server is installed.

2. On the Welcome to VMware vSphere screen, click vSphere Web Client 
(Flash).

IMPORTANT For more information and resource pool priority recommendations for servers 
and workstation, see Resource Pool Allocation in the PlantPAx System
Reference Manual, publication PROCES-RM001.
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3. Type the User name and Password. Use the User name and password that 
you created for the vCenter Server.

4. Click Login.

5. Right-click a host server and choose New Resource Pool.

IMPORTANT The user name consists of the vCenter Single Sign-On user name plus '@' plus 
the Domain name.
In our example, the user name is 'administrator@system.plantpax.local'.
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6. Type the priority in the Name text box. For example, High Performance.

7. Click the Shares pull-down menu and select 'High' for the CPU and 
Memory Resources categories. 

8. Click OK.

9. Repeat step 1 through step 7 for each virtual machine depending if the 
priority is High Performance, Normal Performance, or Low Performance. 

The priority types appear in the tree for the host server.

10. Drag and drop virtual machines to the Resource Pool that matches the 
needs and intended use. Settings for that resource pool are assigned.
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Notes:
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Server Initial Configuration

PlantPAx® system servers (whether physical or virtual machines) share a 
collection of data to clients. This chapter describes how to configure virtual 
server templates. This chapter is performed initially when configuring all system 
elements.

If you plan to deploy a domain controller, we recommend that you configure the 
domain controller before any other system element. 

Virtual templates are available for the following PlantPAx server system elements:
• Process Automation Domain Controller - PADC
• Process Automation System Server - PASS
• SQL Server - AppServ-Info (SQL)
• FactoryTalk® Historian Server - AppServ-Info (Historian)
• FactoryTalk Batch Management Server - AppServ-Batch
• FactoryTalk Asset Management Server - AppServ-Asset
• Operator Workstation Application Server - AppServ-OWS
• Engineer Workstation Application Server - AppServ-EWS
• FactoryTalk VantagePoint® Server - AppServ-Info (VantagePoint)

The required Rockwell Automation® software for each virtual server is included 
and pre-installed in the virtual image templates, but not activated. See 
Activation Considerations on page 201 for activation procedures. 

IMPORTANT Perform this procedure on all servers before configuring the system elements. 
If you already own individual product activations, these activations can also be 
used to activate the virtual image templates.
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Configure Microsoft 
Windows Server 

Complete these steps to configure Microsoft Windows Server 2016 settings for 
your virtual servers.

Windows Server 

Complete these steps to install the server software.

1. From a web browser, enter the IP address of the computer where your host 
server is installed.

2. Type the user name and password for the host server, and click Login. The 
VMware ESXi window appears.

3. From the Navigator in the left pane, right-click the virtual machine that 
you want to configure, and select Power>Power On.

4. Right-click the virtual machine again, and select Console>Launch Remote 
Console.

5. Choose the appropriate location, language, and keyboard settings and click 
Next.

6. On the EULA dialog box, read the license terms and click ‘Accept’.

7. Type a password for administrator, retype the password to verify, and click 
‘Finish.’ 

A logon message appears: ‘Press Ctrl + Alt + Delete to unlock’. Do not 
press Ctrl + Alt + Delete.

8. Press Ctrl+Alt+Insert. 

9. Type the Administrator password that you created and Press Enter.

If you see the Other-User logon, type 'Administrator', type the 
administrator password that you created and Press Enter. Wait until you 
see the network message in the following step.

IMPORTANT Even though ‘Press Ctrl + Alt + Delete …’ is displayed on the screen, you must 
press Ctrl + Alt + Insert to access the virtual machine. The sequence 'Ctrl + Alt 
+ Del' is reserved for the terminal from where you connect to the server that 
hosts the virtual machine.
88 Rockwell Automation Publication 9528-UM001G-EN-P - June 2019



Server Initial Configuration Chapter 3
10. Click ‘Yes’ to allow the PC to be discoverable.

11. Wait until the Product Key window appears.

12. In the Product Key window, type a valid Windows Server Product Key and 
click OK. 

13. Verify that the product key is correct and click Yes.

14. Click OK in the message window when the product key was installed 
successfully.

15. Click OK in the activation window.

Administrative Server 
Configuration

The following procedures help manage who has access to the server and login 
privileges. Complete these procedures on all virtual servers to be deployed.

Create an Administrator User Account

We suggest that you create an Administrator user account for each user that 
requires administrative privileges. This safeguards server corruption by restricting 
access to the default administrative account, and creates a backup of critical 
system information. Each user can be delegated a separate user account with 
password protection.

1. Navigate to the Control Panel. 

2. Click User Accounts. 

3. Click Manage another account. 

4. Click ‘Add a user account’ below the Administrator icon. 

5. Type a name for the user that is being added, a password, retype the 
password for verification, and a hint to remind you of the password. 

6. Click Next, and then Finish on the next dialog box.

7. Click the user that you created. 
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8. Click ‘Change the account type’.

9. On the next window, select Administrator and click ‘Change 
Account Type’.

10. Sign out of Windows.

11. Press Ctrl+Alt+Insert. 

12. Log in with the user that was created.

Even though ‘Press Ctrl + Alt + Delete …’ is displayed on the screen, 
you must press Ctrl + Alt + Insert to access the virtual machine. The 
sequence 'Ctrl + Alt + Del' is reserved for the terminal from where you 
connect to the server that hosts the virtual machine.
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Configure Programs Menu

Complete the steps on the system computers to group folders under ‘Programs’ 
on the taskbar. When complete, you can access Windows and Rockwell Software® 
folders by clicking the symbol next to Programs  on the task bar.

1. Navigate to the Control Panel and choose File Explorer Options. 

2. On the View Tab, select ‘Show hidden files, folders, and drives’ and click 
OK.

3. Right-click on the taskbar, choose Toolbars>New toolbar.

4. On the New Toolbar window, navigate to your Programs folder. 
C:\ProgramData\Microsoft\Windows\StartMenu\Programs

5. Click Select Folder.
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The result is a custom menu with easy access to Rockwell Software conveniently 
located on the Windows taskbar. 

6. Before proceeding, click the Date/Time in the lower right-hand corner of 
the desktop. Verify that the Date and Time settings are correct.

7. Turn off the ‘Set time automatically’ feature in the Date and Time settings.
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Rename the Computer

Complete these steps to rename the computer.

1. Click  from the windows menu to open the Server Manager.

2. On the Server Manager window, click Local Server and then click the 
computer name.

3. Click Change on the System Properties dialog box. 

4. Type a new computer name.

IMPORTANT Do not use spaces, hyphens, or any special character symbols.
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5. Click Domain, type the name of your domain, and click OK.

6. Enter an administrator username and password.

7. Click OK when the welcome to domain window appears.

8. Restart the virtual machine for the changes to the settings to take effect.

9. Log in by using your domain credentials or the local user administration 
account previously created.

Verify Ethernet Network Adapter Settings

Complete these steps to verify the speed, duplex, and power management settings 
for the Ethernet adapter.

1. Navigate to the Control Panel.

2. Click Network and Sharing Center.

3. In the Network and Sharing Center window, click Change Adapter 
Settings.

4. Right-click the Ethernet network connection and choose Properties. 

5. If asked, type your password and click Yes.

IMPORTANT We recommend that you restart your computer so that these changes take 
effect.
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6. In the Ethernet Properties dialog box, click Configure.

7. Click the Advanced tab.

8. Select Speed and Duplex and then choose Auto Negotiation.

9. Click the Power Management tab.

10. Clear the ‘Allow the computer to turn off this device to save power’ 
checkbox.

11. Click OK.

Verify Remote Settings

Complete these steps to configure remote settings for a virtual image to allow 
remote connections to this computer.

1. Right-click the Windows Start icon and choose System.

2. Click Remote settings.
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3. In the Remote Assistance Section at the top of the window, verify that the 
checkbox to ‘Allow Remote Assistance connections to this computer’ is 
not checked.

4. In the Remote Desktop Section, click the ‘Allow remote connections to 
this computer’ box.

5. Click OK.

Verify the Processor Scheduling Setting

Complete these steps to adjust processor scheduling for best performance in the 
Windows Server operating system.

1. Right-click the Windows Start icon and choose System.

2. Click the Advanced system settings.

3. Click Settings in the Performance section.

4. Choose the Advanced tab.

5. Click Background services in the Processor scheduling section to adjust for 
the best performance.

6. Click OK twice.
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Configure the Servers 

PlantPAx® system servers (whether physical or virtual machines) share a 
collection of data to clients. This chapter describes how to configure virtual 
server templates.

If you plan to deploy a domain controller, we recommend that you configure the 
domain controller before any other system element. 

Virtual templates are available for the following PlantPAx server system elements:
• Process Automation Domain Controller - PADC
• Process Automation System Server - PASS
• SQL Server - AppServ-Info (SQL)
• FactoryTalk® Historian Server - AppServ-Info (Historian)
• FactoryTalk Batch Management Server - AppServ-Batch
• FactoryTalk Asset Management Server - AppServ-Asset
• Operator Workstation Application Server - AppServ-OWS
• Engineer Workstation Application Server - AppServ-EWS
• FactoryTalk VantagePoint® Server - AppServ-Info (VantagePoint)

The required Rockwell Automation® software for each virtual server is included 
and pre-installed in the virtual image templates, but not activated. See 
Activation Considerations on page 201 for activation procedures. 

IMPORTANT Complete Chapter 3 Server Initial Configuration on page 87 on all servers 
before configuring any system element.
If you already own individual product activations, these activations can also be 
used to activate the virtual image templates.
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Configure Server Templates Figure 3 contains the topics for the virtual servers that are described in this 
section. The PADC server must be deployed first.

See the page number or click the links for quick access to specific information.

Figure 3 - PlantPAx Virtual Servers

Start

Configure the PADC Virtual Server

See page 99

Configure the PASS Virtual Server

See page 99

Configure the SQL Virtual Server

See page 102

Configure the Historian Virtual Server

See page 113

Configure the Batch Virtual Server

See page 124

Configure the Asset Management 
Virtual Server
See page 132

Configure the AppServ-OWS
AppServ-EWS Virtual Servers

See page 137

Configure the VantagePoint
Virtual Server
See page 144

See Appendix A
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Configure the PADC Virtual 
Server 

A domain controller is a server that responds to security authentication requests 
(logging in, checking permissions, and so forth) within the Windows server 
domain. A domain grants you access to a number of network resources (such as 
applications and printers) with the use of one user name and password 
combination.

The PlantPAx system uses a domain controller to store user account information, 
authenticate users, enforce security policies and best networking practices such as 
automatic network address assignment. Domain authentication is recommended, 
whether it’s an existing domain or a new one.

Before configuring the domain controller, complete the following tasks:
• Chapter 2 Deploy the PlantPAx Virtual Image Templates on page 31.
• Chapter 3 Server Initial Configuration on page 87.

Once you have completed these tasks, see the PlantPAx Distributed Control 
System Infrastructure Configuration User Manual, publication 
PROCES-UM001, for domain controller configuration procedures.

Configure the PASS Virtual 
Server

The Process Automation System Server (PASS) hosts essential software 
components to run your system. The data, human-interface (HMI), and alarm 
servers reside in the PASS.

You must designate a PASS server for the FactoryTalk Directory. The directory 
centralizes the settings and administration of Rockwell Automation software 
components across multiple virtual machines.

The required Rockwell Automation software for the PASS system element is 
included and pre-installed in the PASS virtual image template, but not activated. 
To activate each PASS image, purchase an activation license. See Table  on 
page 10 for catalog numbers.

Before configuring the PASS Server, complete the following tasks:
• Chapter 2 Deploy the PlantPAx Virtual Image Templates on page 31.
• Chapter 3 Server Initial Configuration on page 87.

Configure the FactoryTalk Directory on the PASS

The following procedure describes how to designate the PASS server as the host 
of the FactoryTalk Directory. The directory server manages applications that can 
exist on multiple clients and servers on separate virtual machines on the 
PlantPAx system.

IMPORTANT You must have a user name and password with Administrator privileges to 
specify the FactoryTalk Directory location. Use the same user name and 
password for all FactoryTalk installations on the PlantPAx system.
Rockwell Automation Publication 9528-UM001G-EN-P - June 2019 99

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/proces-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/proces-um001_-en-p.pdf


Chapter 4 Configure the Servers
1. On the virtual image desktop, click the Programs icon and choose 
Rockwell Software>FactoryTalk Tools>FactoryTalk Directory 
Configuration Wizard. 

2. Type your password and click Next.

3. In the FactoryTalk Directory Configuration Wizard page, check the 
following:
• Configure the FactoryTalk Network Directory
• Configure the FactoryTalk Local Directory 

4. Click Next. 

Configuring the local and network FactoryTalk Directories can take up to 
30 seconds to process the request. 

5. Type the FactoryTalk Network Directory credentials for the network 
directory configuration and click Next.

6. Type the credentials for the Local Directory configuration and click Next.

7. Click Close on the summary windows showing that the network 
configuration and the local configuration were completed successfully.

IMPORTANT In the next step, you are creating the credentials as you type them in.
Remember these credentials for later use. Use the Administrator User 
Account credentials that were created in Create an Administrator User 
Account on page 89.
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Delete the Old Computer Name

The old computer name is embedded in the sample applications. Therefore, if 
you want to use the sample applications, complete these steps to rehost the 
applications on the new computer name. You delete the old computer name from 
the FactoryTalk Directory by using the Administration Console.

Deleting the old computer name keeps the FactoryTalk Directory up-to-date 
with current computer names. This deletion also makes sure that applications do 
not attempt to communicate with computers that are no longer in the 
FactoryTalk Directory.

1. Click the Programs icon and choose Rockwell Software>FactoryTalk 
Administrator Console. 

2. Select Network (default directory) and click OK.

Enter the password if necessary.

3. In the Project Explorer pane, click to expand the Computers and Groups 
folder and click to expand the Computers group.

4. Right-click all computer names except the one you created and choose 
Delete.
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5. Click Yes when a message appears and asks you to verify that you want to 
delete the computer name.

6. If you use the Local Directory, repeat step 1 through step 5 and make sure 
to select Local in step 2.

7. When finished, exit the FactoryTalk Administrator console.

8. Restart your computer.

Configure the SQL Virtual 
Server / Historian AF

The AppServ-Info (SQL) server is a database that is used to store Process data for 
FactoryTalk AssetCentre, FactoryTalk VantagePoint, and FactoryTalk Batch 
software programs. The FactoryTalk Alarm and Event server also uses the SQL 
database.

Before configuring the server, complete the following tasks:
• Chapter 2 Deploy the PlantPAx Virtual Image Templates on page 31.
• Chapter 3 Server Initial Configuration on page 87.

Install SQL Server 2012 Standard

1. On the virtual image desktop, click the Programs icon and choose 
Microsoft SQL Server 2012>Configuration Tools>Complete SQL
Server 2012 Installation. 

2. Click Yes to allow the changes to be made to the device.

3. Click OK once all Setup Support Rules have passed.

4. Click Next to continue the setup.

IMPORTANT Use this procedure if you are installing SQL Standard on this server and are 
either installing a separate Historian server or are not using a Historian server. 
If installing a standalone Historian Server with SQL Express, skip this section 
and proceed to Configure the Historian Virtual Server on page 113.

IMPORTANT If installing both a Historian and SQL server, Complete chapter 3 Server Initial 
Configuration on both servers before continuing with this procedure.
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5. Do one of the following:
• Select Specify a free edition and then select Evaluation from the

pull-down menu for a 90-day trial.
• Select Enter the product key and type your key to license your software.

6. Click Next.

7. Read the license terms, and click ‘I accept the license terms’

8. Click Next.

9. Use the default name of your SQL server instance and click Next.

10. Use defaults and click Next for the Feature Review step.

IMPORTANT For the remainder of the installation, default selections are shown and 
we do not recommend any changes. Some PlantPAx configurations 
require these default selections. We recommend accepting the 
defaults, prove the system, and make changes later. Corresponding 
notice is provided where exceptions to this configuration are 
considered for changing now. Otherwise, simply click Next on the 
following screen captures to complete the process.

TIP Change the server name only if you're planning another SQL instance 
on this machine. Observe the SQL instances are addressed by their 
<MachineName>\<InstanceName> combination.
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11. Click Default Instance and click Next for the Instance Configuration step.

12. Use defaults and click Next for the Server Configuration step.

13. Select Mixed mode then enter and confirm the password. Specify the SQL 
Server administrators. At least one must be chosen either by clicking ‘Add 
Current User’ or ‘Add.’ Click Next.

TIP Additional SQL administrators can be added, if necessary. Click Help for 
clarifications.
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14. Specify which users have administrative privileges for Analysis Services. At 
least one must be chosen either by clicking ‘Add Current User’ or ‘Add.’ 
Click Next.

15. Click Next to Install and Configure the report server.

16. Click Next to use the defaults for Error Reporting.

17. Click Next once the Image Rules have completed.

18. Click Complete to finish the configuration of the image.

19. Click Close once the operation is complete.
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Install Historian Asset Framework on SQL Server

The procedures in this section apply only if you plan to do the following:
• Use FactoryTalk Historian Asset Framework in your PlantPAx system
• Install Asset Framework Server on the SQL Server

Install FactoryTalk Services Platform

Perform these steps to install FactoryTalk Services Platform.

1. Navigate to the installation files.
c:\Install Files\6.00.00\FTHistorian\SE-DVDDL.

2. Click Setup.exe.

3. Click ‘Install FactoryTalk Historian Site Edition’. 

4. Click ‘Install FactoryTalk Services’.

5. Click ‘Install FactoryTalk Services’ on this screen as well.

6. Click 'Customize’.

IMPORTANT If you are not installing Asset Framework on the SQL Server, not deploying a 
Historian server, or installing a standalone Historian or you can skip this 
section. Proceed to Add Local User to the SQL Server on page 111.

IMPORTANT The installation files are not included in the SQL Server template. The 
installation files for services platform are located in the Historian template in 
c:\install files\6.00.00\FTHistorian\SE-DVDDL. If Historian is already deployed 
on the network, access the installation files through the network. Otherwise, 
the Historian template can be downloaded from the Product Compatibility and 
Download Center (PCDC) at 
http://compatibility.rockwellautomation.com/Pages/home.aspx.
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7. Clear all software products except for FactoryTalk Services Platform and 
click Install.

8. Read the EULA, and click Accept all.

9. The installation takes several minutes to complete. Click ‘Restart now’ 
once the installation is complete.

10. Press Ctrl+Alt+Insert and log in.

Specify the FactoryTalk Directory Location

Complete these steps on the SQL server to specify the network FactoryTalk 
Directory location.

1. Click the Programs icon and choose Rockwell Software>FactoryTalk 
Tools>Specify FactoryTalk Directory Location.

2. Click Yes to allow the application to make changes to the device.

3. In the FactoryTalk Directory Server Location Utility dialog box, click 
Browse (ellipsis '…').

4. Type your FactoryTalk Directory Administration Console credentials into 
the login screen and click OK.

IMPORTANT Even though ‘Press Ctrl + Alt + Delete …’ is displayed on the screen, 
you must press Ctrl + Alt + Insert to access the virtual machine. The 
sequence 'Ctrl + Alt + Del' is reserved for the terminal from where you 
connect to the server that hosts the virtual machine.
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5. Click Remote computer and click Browse. 

6. Navigate the network to find the computer name of the server (typically 
PASS) that is hosting the FactoryTalk Directory services. Click OK.

7. Click OK to accept the location.

8. Click OK to finalize the location.

9. When prompted, type your credentials and click OK.

10. Restart after you make this change.

IMPORTANT Browse can be inactive if Network Discovery and File Share are not turned on. If 
Browse is inactive, type the computer name of the virtual machine that is 
hosting the FactoryTalk Directory.
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Install Historian Asset Framework

Perform these steps to install Historian Asset Framework.

1. Navigate to the installation files.
c:\Install Files\6.00.00\FTHistorian\SE-DVDDL.

2. Click Setup.exe.

3. Click ‘Install FactoryTalk Historian Site Edition’. 

4. Click 'Install FactoryTalk Historian Asset Framework'.

5. Click ‘Install FactoryTalk Historian AF Server’. An installation wizard 
window opens separately.

6. Click Next on the 'Welcome' window.

7. Read the License Agreement, click 'I accept the terms in the license 
agreement' and click Next.

8. Click Next on the Review Component Installation window.

9. Select the destination drive and click Next.

IMPORTANT The installation files are not included in the SQL Server template. The 
installation files are in the Historian template in c:\install 
files\6.00.00\FTHistorian\SE-DVDDL. If Historian is already deployed on the 
network, access the installation files through the network. Otherwise, the 
Historian template can be downloaded from the Product Compatibility and 
Download Center (PCDC) at 
http://compatibility.rockwellautomation.com/Pages/home.aspx.
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10. Type a period (.) for the 'Database Server name' and click Next

11. Click Install to start the installation process. If a security prompt opens, 
click Run to allow the process to continue.

12. Close the Release Notes, then click Finish to close the wizard.

13. Click Exit to close the Historian Installation window.

IMPORTANT At the end of the installation process (approximately 15…20 
minutes), the Release Notes display in a separate window. The 
installation process is not complete until you close the Release Notes 
window.
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Add Local User to the SQL Server

The installers for Rockwell Automation software use Windows Authentication 
instead of SQL Server Authentication. To complete the installation of Rockwell 
Automation software in system elements that connect to the SQL server, add a 
local administrator account to the SQL server login. These steps are to be 
performed regardless if you use a Historian server collective.

1. On the virtual image desktop, click the Programs icon and choose 
Microsoft SQL Server 2012>SQL Server Management Studio. 

2. On the Connect to Server dialog box, log in to the 'sa' account with SQL 
Server Authentication. 

3. Type the password that you created during the SQL installation (see 
page 104).

4. Click Connect.

5. In the Object Explorer, right-click Security and choose New>Login. 

6. Click Search next to Login Name on the Login - New window.

7. Enter your security credentials.
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8. On the Select User or Group dialog page, click Advanced. 

9. In the Select User or Group dialog box, click Find Now. 

The Search Results are populated.

10. In the Search Results area, select the local administrator account that is 
logged in and click OK. 

The ‘object name’ area on the Select User or Group dialog box is 
populated. 

11. Click OK. 
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The Login name is populated on the Login - New window.

12. Click OK. 

Configure the Historian 
Virtual Server

This template represents a base installation of a FactoryTalk Historian server. The 
template excludes optional features, such as Advanced Server or Datalink. 

We recommend that you install Asset Framework (AF) software on the SQL 
server. Instructions are included in the SQL server section (see page 102). 

If the AF software cannot be installed on the SQL server, see the FactoryTalk 
Historian SE Installation and Configuration Guide for more information on 
locating your Asset Framework Server. The guide is available on the Historian 
server at C:\Program Files (x86)\Common Files\Rockwell\Help.

If you cannot install AF software on the SQL Server or another computer, and 
want to install on the Historian computer, then you are creating a standalone 
Historian server.

Before configuring the server, complete the following tasks:
• Chapter 2 Deploy the PlantPAx Virtual Image Templates on page 31.
• Chapter 3 Server Initial Configuration on page 87.

Use Collective For Historian

For high availability of your Historian server, install two FactoryTalk Historian 
servers and configure the FactoryTalk Historian SE system to store and write 
identical data on each server. Together, this set of servers is called a FactoryTalk 
Historian Server Collective.

The server collective receives data from one or more interfaces and responds to 
requests for data from one or more clients. When one server becomes unavailable, 
another server that contains the same data responds to requests for that data.

If you are implementing a collective, you must deploy two Historian servers. 
Complete all sections of this manual for each Historian server. For more 
information on a server collective, see the PlantPAx Distributed Control System 
Infrastructure User Manual, PROCES-UM001.

IMPORTANT You must install an AF server to complete Historian installation.
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If you choose to use a Historian Collective, you cannot install AF software on 
either of the Historian computers. We recommend that you install AF server on 
the SQL Server computer.

Historian Configuration

Specify the FactoryTalk Directory Location 

To specify the network FactoryTalk Directory location, complete these steps on 
the Historian server. 

1. Click the Programs icon and choose Rockwell Software>
FactoryTalk Tools>Specify FactoryTalk Directory Location.

2. Click Yes to allow changes to be made to this device. 

3. In the FactoryTalk Directory Server Location Utility dialog box, click 
Browse (ellipsis '…').

4. Type your FactoryTalk Directory Administration Console credentials into 
the Login screen and click OK.

IMPORTANT During the configuration of the Historian server, a User Account Control 
window asks if you want to allow a program to make changes to the computer. 
Click Yes.
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5. Click Remote computer.

6. Click Browse (ellipsis '…') and navigate the network to find the computer 
name of the server (typically PASS) that is hosting the FactoryTalk 
Directory services.

7. Choose the appropriate server name and click OK.

The Network FactoryTalk Directory location has now been specified.

8. When prompted, enter your credentials and click OK.

9. Restart AppServ-Info (Historian) after making this change.

IMPORTANT Browse can be inactive if Network Discovery and File Share are not active. 
Manually type the name of the server if necessary.
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Delete Old Computer Name 

Delete the old Historian server name to keep the PI SDK up-to-date with current 
computer names. Complete these steps.

1. Click the Programs icon and choose Rockwell Software>
FactoryTalk Historian SE>FactoryTalk Historian SE System>
PISDK Utility. 

The PI Software Development Kit window opens.

2. In the Explorer pane on the left side of the window, select Connections. 

3. In the server pane, right-click any old Historian server name (other than 
your recently created computer) and choose 'Remove selected Server'. 

TIP The first time the PI SDK is run, it can take several minutes to complete the 
startup and show a display.
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4. Click Yes.

5. Close the utility.

Install SQL Server Express

We recommend that you install FactoryTalk Historian AF software (a 
component of Historian software) on the SQL server. If you cannot install AF 
software on the SQL Server or another computer, and want to install on the 
Historian computer, then you are creating a standalone Historian server. Install 
SQL Server Express and then Asset Framework software. 

1. Navigate to the install files:
C:\Install Files\6.00.00-FTHistorian-SE-DVD\

2. Double-click setup.exe.

3. Run the FactoryTalk Historian SE installation wizard.

4. Click ‘Install FactoryTalk Historian Site Edition’.

5. Click ‘Install FactoryTalk Historian Asset Framework’.

6. Click ‘Install Microsoft SQL Server 2016 Express’.

IMPORTANT If you are installing a standalone historian server, proceed with the next 
section. If you are installing a Historian server with Historian Asset Framework 
on a separate server, skip to Complete Historian Configuration on page 123.

IMPORTANT Proceed with this section only if you plan to implement a standalone
Historian server.
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7. Click OK to choose the default directory.

8. Click the first option to install a new standalone SQL Server.

9. Read the license agreement, accept the terms, and click next.

10. Clear the checkbox for Microsoft updates and click next.

11. Click next in the product update page.

12. Click Next on the Install Rules page.

IMPORTANT For more information on installing Microsoft SQL Server 2016 Express, 
refer to the FactoryTalk Historian Installation and Configuration Guide.
We recommend that you use the default settings during the 
installation of Microsoft SQL Server Express.
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13. Clear the checkbox for R Services on the features page. Leave the default 
option for the rest of the features. Click Next. 

14. Click Next to accept the defaults for Instance Configuration.

15. Click Next to accept the defaults for Server Configuration.

16. Select Mixed Mode, enter the system administrator password, and click 
Next.

TIP R Services are not required but can be installed if an Internet connection is 
available. 
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17. Select Install and Configure for Reporting Services Configuration. Click 
Next.

18. Click Close once the installation is complete. Installation takes 
approximately 15 minutes.

19. Exit the installation wizard.

20. Restart the computer, if prompted.

Install Historian Asset Framework (AF) 

1. Navigate to the install files:
C:\Install Files\6.00.00-FTHistorian-SE-DVD\

2. Double-click setup.exe.

3. Run the FactoryTalk Historian SE installation wizard.

4. Click ‘Install FactoryTalk Historian Site Edition’.

TIP Installing SQL Management tools is optional and requires an Internet 
connection.

IMPORTANT Proceed with this section only if you plan to implement a standalone Historian 
server.
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5. Click ‘Install FactoryTalk Historian Asset Framework’.

6. Click ‘Install FactoryTalk Historian AF Server’.

7. Click Next on the 'Welcome' window.

8. Read the License Agreement, click 'I accept the terms in the license 
agreement,' and click Next.

9. Click Next on the Review Component Installation window.

10. Click Next to use the default destination drive.
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11. Click Next to accept ‘.\sqlexpress’ as the default Database Server Name.

12. Click Install to start the installation process. 

13. Close the Release Notes, and click Finish to close the wizard.

IMPORTANT During the installation process, the Release Notes display in a separate 
window. The installation process is not complete until you close the 
Release Notes window.
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Complete Historian Configuration

When the template is installed, we recommend that you review a FactoryTalk 
publication at http://literature.rockwellautomation.com/idc/groups/literature/
documents/in/hse-in025.pdf ). 

IMPORTANT See the pages that are referenced in the FactoryTalk Historian SE Installation 
and Configuration Guide, publication HSE-IN025A:
• Verify that Historian Services are Running 
• Verify that Historian Server is Updating Data for Default Tags
• Prepare PI MDB to AF Synchronization
• Create Security Mappings
• Adding the Server to the FactoryTalk Directory Connection
• Assigning License Activations to the Historian Server 
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Configure the Batch Virtual 
Server 

This section provides procedures to install FactoryTalk Batch independently, 
with FactoryTalk eProcedure, or with Event archiver.

Before configuring the server, complete the following tasks:
• Chapter 2 Deploy the PlantPAx Virtual Image Templates on page 31.
• Chapter 3 Server Initial Configuration on page 87.

Specify FactoryTalk Directory Location

Complete these steps to specify the FactoryTalk Directory location.

1. On the virtual image desktop, click the Programs icon and choose 
Rockwell Software>FactoryTalk Tools>Specify FactoryTalk Directory 
Location. 

2. In the FactoryTalk Directory Server Location Utility dialog box, click 
Browse (ellipsis '…').

3. In the FactoryTalk Directory Server Configuration dialog box, click 
Remote Computer.

4. Type the name of your PASS server, or click Browse (ellipsis '…'), search for, 
and select your PASS server. 

5. Click OK

IMPORTANT Browse can be inactive if Network Discovery and File Share are not 
enabled.
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6. On the FactoryTalk Directory Server Location Utility dialog box, click 
OK to accept the changes. 

7. Log in to the FactoryTalk server when prompted.

8. Restart the virtual machine.

Install FactoryTalk Batch

The Batch virtual server provides efficient, consistent predictable batch 
processing and supports the reuse of code, recipes, phases, and logic. FactoryTalk 
Batch combines the ISA S88 standard with proven technology that provides the 
flexibility you need to supply your product to market faster.

1. On the desktop, double-click the shortcut to the Batch Installation file 
folder. 

2. Double-click Setup.exe.

3. When the Setup window displays, click Next.
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4. Clear the checkbox for FactoryTalk Event Archiver. Leave FactoryTalk 
Batch checked. Click Next.

5. Check to allow changes to this computer and click Next.

6. Select Network Directory and click Next.

7. Type a user name and password for the batch server.

8. Click Install.

9. On the EULA page, read the license agreement and click 'Accept all'.

10. Select whether to activate now or later and click Next. You must be 
connected to the Internet to activate now.

11. Click Close.

TIP Installation takes approximately 15 minutes.
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Install FactoryTalk eProcedure

The eProcedure® template lets you step through the process of creating and 
commanding a batch. You can view equipment or procedures for batches running 
within the plant. 

1. On the desktop, double-click the shortcut to the Batch Installation file 
folder. 

2. Double-click Setup.exe.

3. When the Setup window displays, click Modify.

4. Check FactoryTalk eProcedure v13.00 and click Next.

5. Select Network Directory and click Next. 

6. Type a user name and password for the batch server.

7. Click Modify.

8. On the EULA page, read the license agreement and click 'Accept all'.

9. Click Close when the modification is complete.

IMPORTANT You must have FactoryTalk Batch installed on the server to complete the 
following procedure.
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Install FactoryTalk Event Archiver

Complete these steps to install the FactoryTalk Event Archiver to insert batch 
record data.

1. On the desktop, double-click the shortcut to the Batch Installation file 
folder. 

2. Double-click Setup.exe.

3. When the Setup window displays, click Modify.

4. In the FactoryTalk Batch window, click FactoryTalk Event Archiver 
v13.00.

5. Click Next.

IMPORTANT You must have FactoryTalk Batch installed on the server to complete the 
following procedure.
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6. Type your SQL server name. Use the Default Instance, Source Name, and 
Include Batch Reports.

7. Click Next.

8. Click Modify once the connection is validated.

9. On the EULA page, read the license agreement and click 'Accept all'.

10. Click Close once the modification is complete.

TIP Installation takes approximately 3 minutes.
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Configure the Windows Firewall (Optional)

To configure the Windows firewall, complete these steps.

1. On the virtual image desktop, click the Programs icon and choose 
Rockwell Software>FactoryTalk Tools>Windows Firewall Configuration 
Utility. 

2. If the firewall has not been enabled, the following dialog box can open. 
Click Yes to enable the fire wall and continue. 

3. In the Rockwell Software Windows Firewall Configuration Utility 
window, click Accept. If no changes are required Click Exit. 

4. Click OK on the Confirm Windows Firewall Changes dialog box.

The utility configures the Windows firewall and the firewall is set to a new 
state (if different).
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Complete Batch Installation

At this point, the FactoryTalk Batch virtual server is ready for use. Review the 
Installation Guide for FactoryTalk Batch, publication BATCH-IN002. 

We recommend that you use a domain. If the Batch server is in a workgroup, 
complete these additional tasks:

• Add an incoming firewall rule
• Disable Administrative Approval Mode

For these procedures, see the Batch Installation Guide (‘Configure Batch Server 
to run in a Workgroup’) and the eProcedure manual. 

• The FactoryTalk Batch Installation Guide is in your template at C:\Install 
Files\Batch Installation Software\13.00.02-FTBatch-ePro-MatMgr-DVD

• The FactoryTalk Batch Administrator’s Guide is in your template at c:\ 
Program Files (x86)\Commion Files\Rockwell\Help. 
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Configure the Asset 
Management Virtual Server

An asset management server (AppServ-Asset) helps to manage and maintain 
plant operations. The AppServ-Asset server provides controller data backup for 
disaster recovery, diagnostics, calibration, and real-time monitoring. The server 
also audits equipment and network health to improve overall
resource availability.

Before configuring the server, complete the following tasks:
• Chapter 2 Deploy the PlantPAx Virtual Image Templates on page 31.
• Chapter 3 Server Initial Configuration on page 87.

Configure a Firewall

This section describes how to enable a firewall.

Complete these steps.

1. On the virtual image desktop, click the Programs icon and choose 
RockwellSoftware>FactoryTalk Tools>Windows Firewall Configuration 
Utility. 

2. If the firewall has not been enabled, the following dialog box can open. 
Click Yes to enable the firewall and continue. 

3. In the Rockwell Software Windows Firewall Configuration Utility 
window, click Accept. If no changes are required Click Exit.

4. Click OK on the Confirm Windows Firewall Changes dialog box.

The utility configures the Windows firewall and the firewall is set to a new 
state (if different).

IMPORTANT Before proceeding, there must be a connection between this computer and the 
computer where the FactoryTalk Directory resides. There must also be a 
connection between this computer and the SQL server.
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Specify FactoryTalk Directory Location

In this section, you specify the location of the FactoryTalk Directory.

Complete these steps.

1. On the virtual image desktop, click the Programs icon and choose 
Rockwell Software>FactoryTalk Tools>Specify FactoryTalk Directory 
Location. 

2. In the FactoryTalk Directory Server Location Utility dialog box, click 
Browse (ellipsis '…').

3. In the FactoryTalk Directory Server Configuration dialog box, click 
Remote Computer.

4. Type the name of your PASS server, or click Browse (ellipsis '…'), search for, 
and select your PASS server. 

5. Click OK

6. On the FactoryTalk Directory Server Location Utility dialog box, click 
OK to accept the changes. 

7. Log in to the FactoryTalk server when prompted.

8. Restart the virtual machine.

IMPORTANT Browse can be inactive if Network Discovery and File Share are not 
enabled.
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Create a New Inbound Rule

There must be an inbound rule that allows a connection through the firewall to 
the AppServ-Info (SQL) server.

1. On the virtual image desktop, click the Programs icon and choose 
Administrative Tools>Windows Firewall with Advanced Security.

2. In the Windows Firewall with Advanced Security, click Inbound Rules.

3. Right-click Inbound rules and select New Rule. 

4. In the Rule Type dialog box, click Port and then click Next. 

5. Select TCP and Specify local ports.

6. Type '1433' as the specific local port. 

7. Click Next. 

8. Select 'Allow the connection' and then click Next. 
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9. Make sure that all boxes are checked and click Next.

10. Type External SQL Connection in the Name field and click Finish.

The firewall now permits connections to the external SQL server in a 
secure manner.
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Configure FactoryTalk AssetCentre Software

AssetCentre must be configured to account for changes in computer name, 
FactoryTalk Directory, and SQL location. 

1. Open the Server Setup shortcut on the desktop and run the 
FTAssetCentre.DBInstaller.exe file.

2. Type the name of the SQL server in the server section. Log in with the ‘sa’ 
user account created when installing the SQL server.

3. Click Start.

4. Type a password for the AssetCentreUser account. Click OK.

5. Click YES to acknowledge creating the new user.

6. Open the Server Setup shortcut on the desktop and run the 
FTAssetCentre.AosCatalogImport.exe file.

IMPORTANT Before proceeding, there must be a connection between this computer and the 
computer where the FactoryTalk Directory resides. There must also be a 
connection between this computer and the SQL server.
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Configure the AppServ-OWS/
AppServ-EWS Virtual Servers

This section describes procedures for configuring an AppServ-OWS and 
AppServ-EWS. The procedure is the same for both servers.

Application servers for EWS and OWS allow multiple instances of EWS and 
OWS workstations to be deployed by using Microsoft Remote Desktop Services 
(RDS).

Before configuring the server, complete the following tasks:
• Chapter 2 Deploy the PlantPAx Virtual Image Templates on page 31.
• Chapter 3 Server Initial Configuration on page 87 if deployed on a server.
• Chapter 5 Configure the Servers on page 97 if deployed on a workstation.

The Rockwell Automation software for the AppServ-OWS and AppServ-EWS 
virtual templates is included and pre-installed in the virtual image templates, but 
not activated. See Activation Considerations on page 201 for activation 
procedures. See page 10 for product catalog numbers.

IMPORTANT If you already own individual product activations, these activations also can be 
used to activate the instances of these virtual image templates you deploy. 
Each instance requires its own Rockwell Automation license and Microsoft 
license.
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Specify the FactoryTalk Directory Location

Complete these steps to specify the network FactoryTalk Directory location for 
EWS and OWS workstations.

Complete these steps on the SQL server to specify the network FactoryTalk 
Directory location.

1. Click the Programs icon and choose Rockwell Software>FactoryTalk 
Tools>Specify FactoryTalk Directory Location.

2. Click Yes to allow the application to make changes to the device.

3. In the FactoryTalk Directory Server Location Utility dialog box, click 
Browse (ellipsis '…').

4. Type your FactoryTalk Directory Administration Console credentials into 
the login screen and click OK.

5. Click Remote computer and click Browse. 

6. Navigate the network to find the computer name of the server (typically 
PASS) that is hosting the FactoryTalk Directory services. Click OK. 

If Browse is inactive, type the computer name of the virtual machine that is 
hosting the FactoryTalk Directory.

7. Click OK to accept the location.

IMPORTANT To complete this procedure, a PASS server must be configured on your system. 
The workstation being configured must have an established connection with 
the PASS server.

IMPORTANT Browse can be inactive if Network Discovery and File Share are not turned on.
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8. Click OK to finalize the location.

9. When prompted, type the FactoryTalk Directory Administrator username 
and password and click OK. 

10. Restart after you make this change.

Install PI Builder Excel Add-in

1. On the single-server image, click the PIAF setup folder shortcut on the 
desktop.

2. Double-click the setup file. PI-AF-Services_2017-R2A_.exe

3. Click Next.

TIP The credentials were configured in Configure the FactoryTalk Directory on the 
PASS on page 99.

IMPORTANT This section is not performed for OWS. Proceed to Configure Remote Desktop 
Services on page 141.

IMPORTANT Microsoft Excel 2010 SP2 or later must be installed before continuing.
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4. Check the box for PI Builder and make sure that all other boxes are 
cleared.

5. Click Next.

6. Click Install to accept the defaults and begin installation.

7. Click Reboot once the installation is finished.
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Configure Remote Desktop Services

The AppServ-OWS and AppServ-EWS provide PlantPAx users with an 
alternative to the standard OWS and EWS client machine (physical or virtual). 
Both application servers use Microsoft Remote Desktop Services (RDS). RDS 
technology allows multiple instances of the OWS and EWS from one virtual 
server. 

This architecture is ideal for PlantPAx users that use thin clients as Operator and 
Engineering workstations.  

Microsoft RDS (formerly known as Terminal Services) is a standard role that is 
built into the Windows server family of operating systems. RDS provides remote 
access to applications and data on a remote computer over a network. This 
solution minimizes the amount of information traveling across your network.

RDS can be used as an administrative tool to connect to a remote machine and 
perform maintenance tasks. RDS can also be used as a thin-client solution to let 
remote clients execute applications or even access the entire desktop of the host 
server.

The thin-client solution is a transparent system that runs applications and 
performs data processing and storage functions on a remote computer. This 
solution minimizes the amount of information traveling across your network. 
While multiple sessions can run on one server, each user can see only their 
individual session. Only the user interface is shown on client, user input from 
client is redirected over the network to the remote desktop session. User's 
desktops are transmitted to clients for display by using terminal emulation 
software. Similarly, the software sends command functions such as keyboard 
inputs and mouse clicks across the network between the client and the server.

IMPORTANT A valid FactoryTalk activation is still required for each instance of the OWS and 
EWS that is in use.
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The PlantPax AppServ-OWS and AppServ-EWS are pre-configured with the 
RDS server role. This configuration provides a thin-client solution for 
FactoryTalk View SE clients.

Users, with the proper credentials, can log in into the AppServ-OWS and 
AppServ-EWS and run the desired application.

One Rockwell Automation software activation key is required for each remote 
desktop session.

Remote Desktop Services with FactoryTalk View SE

RDS features the following benefits with FactoryTalk View SE software:
• Increased network flexibility: RDS lets you deploy thin and ultrathin 

clients on the plant floor or out in the field. The minimal requirements of 
RDS clients allow for various thin products that are designed to handle 
most environmental conditions. These conditions include radical 
temperatures, extreme vibrations, or areas where mobility is key.

Users can gain access to an RDS over any Transmission Control Protocol/
Internet Protocol (TCP/IP) connection, including the following:
– Remote access
– Ethernet
– Internet
– Wireless
– Wide area network (WAN)
– Virtual private network (VPN)

• Lower cost of ownership: A thin client typically consists only of the 
operating system and the Remote Desktop Connection software. RDS 
delivers a virtual Windows Server experience from server to clients, 
regardless of what operating system the client uses.

• Minimize downtime: Upgrade your entire FactoryTalk View SE 
installation with a single operation. Because FactoryTalk View SE products 
install only on the server side, any future software upgrades are limited to 
the server, making software upgrades on clients a thing of the past.

• Improve data security: A FactoryTalk View SE architecture that uses 
RDS is less vulnerable to security threats. RDS lets you focus your security 
measures on the server because all data is processed on the server, which 
you can manage in a secure location.

RDS has the following limitations with FactoryTalk View SE software:
• The Microsoft RDS protocol does not transfer the physical display aspect 

ratio (height/width proportion) from the server to its clients. Clients need 
to specify the display properties (resolution, aspect ratio, color depth, and 
so forth) for each session they create. Verify the appearance of the 
application visually on the Remote Desktop clients before placing the 
system in a production environment, modifying graphics as necessary.
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• If your FactoryTalk View SE client configuration (.cli) enables 'Show 
Diagnostics List', the list shows all activity from all clients that run on the 
same Remote Desktop session host. Although each instance of the 
FactoryTalk View SE client runs in a separate session, they are all hosted on 
the same computer. And, they share common log resources. This amount 
of activity can be confusing for HMI operators because they see diagnostic 
activity on their client that they did not initiate.

Additional Services 

IMPORTANT You can add additional role services to your server depending on your specific 
deployment of RDS and connectivity needs. These added services can add 
additional configuration beyond which this base RDS has been configured for.

TIP Remote Desktop Services uses its own method of licensing clients that log on 
to Remote Desktop Services servers. This method is separate from licensing for 
the Windows Server family of operating systems. Therefore, AppServ-OWS and 
AppServ-EWS Remote Desktop Connections must receive a valid license. This 
license must be issued by a Remote Desktop Licensing Server before they can 
log on to a Remote Desktop Session Host or Connection Broker.
For volume licensing of these components, contact your Microsoft distributor.
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Configure the VantagePoint 
Virtual Server

AppServ-Info can be configured as a decision support tool by using FactoryTalk® 
VantagePoint EMI software. VantagePoint EMI is a powerful web-based business 
intelligence solution that is designed specifically for industrial environments with 
premier Logix integration. VantagePoint EMI integrates all data into one 
information management and decision support system by connecting to your 
Logix controllers, OPC data sources, Historians, and SQL/Oracle Databases. 
With an AppServ-Info (VantagePoint) system element in your PlantPAx DCS, 
you can access your production data from anywhere including your shop floor 
devices, PC, or your mobile phone or tablet.

Before configuring the server, complete the following tasks:
• Chapter 2 Deploy the PlantPAx Virtual Image Templates on page 31.
• Chapter 3 Server Initial Configuration on page 87.

Specify the FactoryTalk Directory Location

Complete these steps on the server to specify the network FactoryTalk Directory 
location.

1. Click the Programs icon and choose Rockwell Software>FactoryTalk 
Tools>Specify FactoryTalk Directory Location.

2. Click Yes to allow the application to make changes to the device.

3. In the FactoryTalk Directory Server Location Utility dialog box, click 
Browse (ellipsis '…').

4. Type your FactoryTalk Directory Administration Console credentials into 
the login screen and click OK.

5. Click Remote computer and click Browse. 

IMPORTANT To complete this procedure, a PASS server must be configured on your system. 
The workstation being configured must have an established connection with 
the PASS server.

IMPORTANT Browse can be inactive if Network Discovery and File Share are not turned on.
144 Rockwell Automation Publication 9528-UM001G-EN-P - June 2019



Configure the Servers Chapter 4
6. Navigate the network to find the computer name of the server (typically 
PASS) that is hosting the FactoryTalk Directory services. Click OK. 

If Browse is inactive, type the computer name of the virtual machine that is 
hosting the FactoryTalk Directory.

7. Click OK to accept the location.

8. Click OK to finalize the location.

9. When prompted, type the FactoryTalk Directory Administrator username 
and password and click OK. 

10. Restart after you make this change.

TIP The credentials were configured in Configure the FactoryTalk Directory on the 
PASS on page 99.
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Install VantagePoint Server Software

Complete these steps to install FactoryTalk VantagePoint software.

1. Navigate to the installation setup folder:
c:\Install Files\8.10.00-VantagePoint-EMI-DVD 

2. Double-click setup.exe. 

3. Click Install FactoryTalk VantagePoint.

4. Click Install FactoryTalk VantagePoint.

5. If you have not installed Microsoft Excel, you see this warning. Read the 
warning and, according to your needs, click Yes or No. 

In our example, we click Yes to show the installation of FactoryTalk 
VantagePoint when Microsoft Excel is not installed in the VantagePoint 
Server.

6. Click Next on the Wizard Welcome page.
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7. Read the License Agreement, click 'I accept the terms in the License 
Agreement’, and click Next.

8. Click Express on the 'Choose Setup Type' page.

A warning appears if you have not installed Microsoft Excel. 

9. Click OK. 

10. In the Database Connection Information page, type the name of the SQL 
server, click SQL Server, and type credentials for the database. 

11. Click Next.

12. Type the Domain name, user name for the Domain controller, and 
password for the Domain controller in the System/Office User page

13. Click Next.

14. Click Install.

15. Click Finish. 
A DOS window opens to finish the configuration. It closes automatically.

IMPORTANT Type the password that you created when completing the SQL Server 
installation when deploying the SQL Server template.
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Install Microsoft Excel Add-In

The Microsoft Excel add-in enables FactoryTalk VantagePoint to generate Excel 
spreadsheet reports. Complete these steps to install the Excel add-on software.

1. Navigate to the installation setup folder:
c:\Install Files\8.10.00-VantagePoint-EMI-DVD 

2. Double-click setup.exe. 

3. Click Install FactoryTalk VantagePoint.

4. Click Install FactoryTalk VantagePoint.

5. Click Next on the Wizard Welcome page.

6. Click Modify on the Modify, Repair, or Remove installation page. 

IMPORTANT If you are installing FactoryTalk VantagePoint in a VantagePoint server with 
Microsoft Excel installed on it, install the Microsoft Excel Add-In for FactoryTalk 
VantagePoint during the FactoryTalk VantagePoint installation.
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7. Click the VantagePoint Office pull-down menu and select ‘Will be 
installed on local hard drive.’ 

8. Click Next.

9. Click Install.

10. Type the Domain name, user name for the Domain controller, and 
password for the Domain controller in the System/Office User page

11. Click Next. 

The Microsoft Excel software program starts and a VantagePoint 
Configuration warning appears.

12. Close Microsoft Excel and click OK in the warning. 

A series of VantagePoint server configurations are performed. You return 
to the VantagePoint Manager window when the configurations are done.

13. Click Finish.
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Notes:
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Workstation Common Configuration

This chapter describes how to configure the Engineering Workstation (EWS) 
and Operator Workstation (OWS) for your virtualized PlantPAx® system.

This chapter describes the following configuration procedures:
• Microsoft Windows software
• Network adapter settings
• FactoryTalk® Directory location

The EWS supports system configuration, application development, and 
maintenance functions of the PlantPAx system. The EWS is the central location 
to monitor and maintain system operations.

The OWS supports operator interaction and control of the process through a 
human machine interface (HMI).

The required Rockwell Automation® software for each virtual server is included 
and pre-installed in the virtual image templates, but not activated. See 
Activation Considerations on page 201 for activation procedures. 

IMPORTANT The configuration procedures for the Engineering Workstation (EWS) and 
Operator Workstation (OWS) are similar even though these PlantPAx system 
elements operate differently.

IMPORTANT If you own individual product activations, these activations can be used to 
activate the virtual image templates. 
During the configuration of EWS and OWS stations, you can encounter a User 
Account Control window that asks if you want to allow a program to make 
computer changes. Click Yes to continue.
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Before You Begin You must have deployed your template from a USB drive or from a local template 
before performing the following procedures. If you deploy a virtual image 
template into your system, see Chapter 2 on page 31 for details.

Configure Microsoft Windows Complete these steps to configure Microsoft Windows settings for the EWS and 
OWS workstations.

1. From a web browser, enter the IP address of the computer where your host 
server is installed.

2. Type the user name and password for the host server, and click Login.

The VMware ESXi window appears.

3. From the Navigator in the left pane, right-click the virtual machine that 
you want to configure, and select Power>Power On.

4. Right-click the virtual machine again, and select Console>Launch Remote 
Console.

5. Select the appropriate region and click Yes.

6. Select a keyboard layout for the appropriate language and click Yes.

7. Next you are asked if you want to add a second keyboard layout. Choose 
‘Add layout’ if you want a second keyboard layout. Otherwise, click ‘Skip.’ 

8. Click ‘Skip for now’ for an internet connection.

9. Click Accept for the license agreement.

10. Type a user name and click Next.

11. Create a password and click Next.
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12. Retype the password to confirm your entry.

13. Click Next.

14. Create three security questions, and click Next.

15. Click No when prompted to make Cortana your personal assistant.

16. Turn Off all privacy settings for your device and click Accept.

17. Enter the Windows product key.
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Configure Programs Menu

Complete the steps on the system computers to group folders under ‘Programs’ 
on the taskbar. When complete, you can access Windows and Rockwell Software® 
folders by clicking the Programs  symbol on the task bar.

1. Navigate to the Control Panel and choose File Explorer Options. 

2. On the View Tab, select ‘Show hidden files, folders, and drives’
and click OK.

3. Right-click on the taskbar, choose Toolbars>New toolbar.

4. On the New Toolbar window, navigate to your Programs folder. 
For example: 
C:\ProgramData\Microsoft\Windows\StartMenu\Programs

5. Click Select Folder.
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The result is a custom menu with easy access to Rockwell Software conveniently 
on the Windows taskbar. 

6. Before proceeding, click the Date/Time in the lower right-hand corner of 
the desktop. Verify that the Date and Time settings are correct.

7. Turn off the ‘Set time automatically’ feature in the Date and Time settings.
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Standard Workstation 
Configuration

The following procedures apply to EWS and OWS workstations.

Rename the Computer

You have the option of giving the computer another name than the one assigned 
during configuration of the Windows settings. Or, you can add the workstation 
to a domain by performing these steps.

1. Navigate to the Control Panel on the workstation and select ‘System’.

2. Click ‘Change Settings’ in the computer name, domain, and workgroup 
settings area. 

3. On the System Properties window, on the Computer Name tab, click 
Change.

4. Type a computer name in the Computer Name box. 

 

5. Select Domain and type a domain name or Workgroup (default) and type 
a workgroup name.

6. Click OK.

IMPORTANT Do not use spaces, hyphens, or any special character symbols.

IMPORTANT We recommend that PlantPAx servers and workstations be members of 
a Windows domain for systems with 10 or more computers. The 
domain centralizes administration of the users, groups, and security 
settings.
You must have an appropriate domain user account and proper 
credentials to add the computer to a domain.
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7. Type an Administrator username and password.

8. When prompted, restart the workstation so the changes to the settings 
take effect. 

9. Log in by using your domain credentials or the local user administration 
account.

Configure Ethernet Network Adapter Settings

Complete these steps to set the speed, duplex, and power management settings 
for the Ethernet adapter.

1. Click Start and choose Control Panel.

2. Click Network and Sharing Center. 

The Network and Sharing Center dialog box appears.

3. Click Change Adapter Settings.

4. Right-click Local Area Connection and choose Properties. The Network 
Properties dialog box appears.

5. Click Configure.

6. Click the Advanced tab.

7. From the Property window, choose Link Speed and Duplex.

8. From the Value menu, choose Auto Negotiation. 

9. Click the Power Management tab.

10. Clear the ‘Allow the computer to turn off this device to save power’ 
checkbox.

11. Click OK.
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Configure Remote Settings

Complete these steps to configure remote settings for a workstation to allow 
remote connections to this computer.

1. Navigate to the Control Panel.

2. Choose System.

3. Click Remote settings.

4. In the Remote Assistance Section, verify that the checkbox to ‘Allow 
Remote Assistance connections to this computer’ is not checked.

5. In the Remote Desktop Section, click the ‘Allow remote connections to 
this computer’ box.

6. Click OK.

Adjust the Processor Scheduling Setting

Complete these steps to adjust processor scheduling for best performance in the 
Windows 10 operating system.

1. Navigate to the Control Panel.

2. Choose System.

3. Click the Advanced system settings.

4. Click Settings under Performance.

5. Select the Advanced tab.

6. Select ‘Adjust for best performance.

7. Click OK.

EWS / OWS Configuration

See Configure the AppServ-OWS/AppServ-EWS Virtual Servers on page 137 to 
continue the configuration.

TIP The configuration is the same from this point forward for both server and 
workstation-based EWS and OWS.
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Configure PASS-C / OWS ISO

For small and medium systems, this option provides for multiple system 
elements to be on the same physical server. Thus the elements are consolidated 
on the PASS, which is referred to as PASS-C to differentiate from a traditional 
PASS server. We suggest that your system not have more than 2000 I/O points 
for this consolidated server.

USB device is a bootable device that contains an installable consolidated PASS 
for a physical machine. The device has pre-installed applications that are 
required on the PASS-C, including the following:

• FactoryTalk® Directory
• Data server
• HMI server (one server license only is required)
• Alarm server
• FactoryTalk Historian
• FactoryTalk VantagePoint®
• FactoryTalk AssetCentre
• SQL server

IMPORTANT This chapter explains how to configure a physical computer as a PASS-C 
server or as an OWS workstation. A template is not used with these 
procedures as is the case with other servers that are described in Chapter 3.

IMPORTANT The USB device contains a bootable installation of a PASS-C server or OWS 
workstation.
A purchase of a PASS-C or OWS ISO includes an Electronic Software Delivery 
(ESD) version available for download from the Product Compatibility and 
Download Center. The ESD is one file (.ISO type) which can be used to create 
your own bootable device. Typical bootable devices that you can create are 
DVDs and USB storage devices. We do not provide procedures for creating 
bootable devices. Several third-party resources are available (for example, 
PowerISO, RUFUS, and so on) for purchase. 
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Figure 4 lists the topics to configure a PASS-C server. You must complete the 
tasks in the order listed.

See the page number or click the links for quick access to specific information.

Figure 4 - PASS-C Server Workflow

Start

Install PASS-C

See page 161

Configure Windows Settings

See page 163

Adjust SQL Express 
Settings

See page 174

Configure the FactoryTalk Directory

See page 184

Configure FactoryTalk AssetCentre

See page 188

Configure FactoryTalk Historian

See page 191

Configure FactoryTalk VantagePoint
See page 193

Activations
See page 201

Install SQL Server 
2012 Standard
See page 169

SQL Express?
YES NO

Install Historian Asset Framework

See page 179
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Install PASS-C Complete these steps to install the PASS-C.

1. Make sure that your computer is capable of booting from a USB drive. 
Enter the BIOS Setup as the computer is powering on (typically by 
pressing the F2 key). Make sure that the Boot options include booting 
from a USB device.

2. Shut down the computer and connect the USB drive.

3. Turn on the computer. While the computer is powering on, strike the 
F12 key to open the boot options screen. 

4. Select the USB device containing the PASS-C installation.

5. On the Windows Setup dialog box, select your options from the
pull-down menus.

6. Click Next.

7. Enter the product key or Click I don’t have a product key.

8. Click Install Now. 

9. Click “I accept the license terms”, and click Next.

10. Click Custom (installation).
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11. To store the installation, select the hard disk drive.

If necessary, delete any existing drive partitions and format the drive 
location.

12. Click Next.

The installation typically takes about an hour.

The computer automatically restarts. You must log on to complete
the installation.

13. Type an Administrator password (for your system).

14. Type a confirmation password and click Finish.

The installation is complete.
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Configure Windows Settings This section describes how to configure the Windows server to enhance
system performance.

1. Login using the administrator account and password that was created in 
the previous step. 

2. In the Product Key window, type a valid Windows Server Product Key 
and click OK. 

3. Verify that the product key is correct and click Yes.

4. Click OK in the message window when the product key was installed 
successfully.

5. Install any required drivers for your hardware (graphics, Ethernet, 
chipset, and so on).

6. Right-click the windows start icon and select ‘System’.
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7. Click ‘Change Settings’.

8. Click Change on the System Properties dialog box. 

9. Enter the new computer name. Click OK. 

10. Acknowledge any prompts that indicate that a restart is required.

11. Click the Advanced tab.

12. Click Settings in the Performance section.

13. Choose the Advanced tab.

14. Click Background services in the Processor scheduling section to adjust 
for the best performance.

15. To help protect against viruses and security threats, click the Data 
Execution Prevention tab.

IMPORTANT Do not use spaces or any special character symbols.

IMPORTANT Do not restart your computer now. 
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16. Select ‘Turn on DEP for essential Windows programs and services only’ 
and click Apply.

17. Acknowledge the prompt that changes will take effect on restart.

18. Click OK to close the window.

19. On the Remote tab, click ‘Allow remote connections to this computer’.

IMPORTANT Do not restart the computer now.
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20. Click OK to enable the Remote Desktop Firewall exception.

21. Remove the check mark from the ‘Allow connections only from 
computers ...’ box and click Apply.

22. Click Restart Later.

23. Navigate to the Control Panel.

24. Click Power Options.

25. Select ‘High Performance’ in the Preferred Plans section.

IMPORTANT Do not restart the computer now.
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Verify Ethernet Network Adapter Settings

Complete these steps to verify the speed, duplex, and power management 
settings for the Ethernet adapter.

1. Navigate to the Control Panel.

2. Click Network and Internet.

3. Click Network and Sharing Center.

4. In the Network and Sharing Center window, click Change Adapter 
Settings.

5. Right-click the Ethernet network connection and choose Properties. 

6. If asked, type your password and click Yes.

7. In the Ethernet Properties dialog box, click Configure.

8. Click the Advanced tab.
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9. Select Speed and Duplex and then choose Auto Negotiation.

10. Click the Power Management tab.

11. Clear the ‘Allow the computer to turn off this device to save power’ 
checkbox.

12. Click OK.

13. Restart your computer.
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Configure System Software

Install SQL Server 2012 Standard

Complete these steps.

1. Do the following based on the server that is being used:
a. If using SQL Server Express, skip to Adjust SQL Server Express Settings on 

page 174.
b. If using SQL Server 2012 Standard, continue with this procedure.

2. On the virtual image desktop, click the Programs icon and choose 
Microsoft SQL Server 2012>Configuration Tools>Complete SQL
Server 2012 Installation. 

3. Do one of the following:
• Select Specify a free edition and then select Evaluation from the

pull-down menu for a 90-day trial.
• Select Enter the product key and type your key to license your 

software.

4. Click Next.

5. Read the license terms, and click ‘I accept the license terms’

6. Click Next.

IMPORTANT SQL Server Express has already been installed on this machine. If you plan to 
use SQL Express, skip to Adjust SQL Server Express Settings on page 174. If 
you plan to use SQL Server 2012 Standard, continue with the next procedure.

IMPORTANT For the remainder of the installation, default selections are shown and we 
do not recommend any changes. Some PlantPAx configurations require 
these default selections. Best practice is to accept the defaults, prove the 
system, and make changes later. Corresponding notice is provided where 
exceptions to this configuration are considered for changing now. 
Otherwise, simply click Next on the following screen captures to complete 
the process.
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7. Use the default name of your SQL server instance and click Next.

8. Use defaults and click Next for the Feature Review step.

9. Click Default Instance and click Next for the Instance Configuration 
step.

10. Use defaults and click Next for the Server Configuration step.

IMPORTANT Change the server name only if you're planning another SQL instance on this 
machine. Observe the SQL instances are addressed by their 
<MachineName>\<InstanceName> combination.
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11. Select Mixed mode then enter and confirm the password. Specify the 
SQL Server administrators. At least one must be chosen either by 
clicking ‘Add Current User’ or ‘Add.’ Click Next.

12. Specify which users have administrative privileges for Analysis Services. 
At least one must be chosen either by clicking ‘Add Current User’ or 
‘Add.’ Click Next.

13. Click Next to Install and Configure the report server.

IMPORTANT Additional SQL administrators can be added, if necessary. Click Help for 
clarification.
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14. Click Next to use the defaults for Error Reporting.

15. Click Next once the Image Rules have completed.

16. Click Complete to finish the configuration of the image.
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17. Click Close once the operation is complete.

18. Skip to Install Historian Asset Framework on page 179. 

IMPORTANT Do not perform the following procedure, Adjust SQL Express Settings, if you 
just installed SQL Server Standard. Skip to installing Historian Asset 
Framework.
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Adjust SQL Server Express Settings

1. Log in as Administrator.

2. Navigate to Programs>Microsoft Server 2012>SQL Server 
Management Studio.

3. Enter the server name. 
The Server name is <ComputerName>\SQLEXPRESS. 
Where <ComputerName> = the computer name set in Configure 
Windows Settings on page 163.

4. Log on by using the ‘sa’ account and Rockwell1 as the password.

5. Click Connect.

IMPORTANT Do Not perform this procedure if you just completed installing SQL Server 
Standard. Skip to Install Historian Asset Framework on page 179.

IMPORTANT After you complete the initial settings, change your logon and 
password settings under Options.

IMPORTANT The old Administrator account contains the old computer name and must be 
deleted. Perform the following steps to delete the existing account and 
create a new account. 
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6. From the SQL Server Management Studio configuration tree, click 
Security>Logins and select the Administrator account as illustrated.

7. Right-click the Administrator account and choose Delete.

8. Click OK and accept any prompts.
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Add Administrator Account to Computer

We must add the Administrator account by using the new computer name. 

1. From the SQL Server Management Studio configuration tree,
right-click the Logins folder and choose New Login.

2. To create the Administrator login, click Search.

3. Type ‘administrator’ in the object name box and click Check Names.

4. Verify that the user is successfully verified, and click OK.

5. Click Server Roles and checkboxes for public and sysadmin.
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6. Click Securables and then click Search.

7. To retrieve the server name, click the last option.

The example is PLANTPAX\SQLEXPRESS.

The server name appears under Securables.

8. In the Permission section, click Grant to enable the
Connect SQL option.

9. Click OK.
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Configure AssetCentre User Account

Complete these steps.

1. Right-click on AssetCentreUser under Logins and choose Properties.

2. Configure a password for the account.

3. Click OK.

4. Close SQL Server Management Studio.
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Install Historian Asset Framework

The procedures in this section apply only if you plan to do the following:
• Use FactoryTalk Historian Asset Framework in your PlantPAx® system
• Install Asset Framework Server on the Server

Perform these steps to install Historian Asset Framework.

1. Navigate to the installation files.
c:\Install Files\6.00.00-FTHistorian-SE-DVD.

2. Double-click Setup.exe.

3. Click ‘Install FactoryTalk Historian Site Edition’. 

4. Click 'Install FactoryTalk Historian Asset Framework'.

5. Click ‘Install FactoryTalk Historian AF Server’. An installation wizard 
window opens separately.

6. Click Next on the 'Welcome' window.

7. Read the License Agreement, click 'I accept the terms in the license 
agreement' and click Next.

8. Click Next on the Review Component Installation window.

9. Select the destination drive and click Next.

10. Type a period (.) for the 'Database Server name' if using SQL standard. If 
you are using SQL Express, type .\sqlexpress and click Next.
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Figure 5 - SQL Server

Figure 6 - SQLEXPRESS

11. Click Install to start the installation process. If a security prompt opens, 
click Run to allow the process to continue.

12. Close the Release Notes, then click Finish to close the wizard.

13. Click Exit to close the Historian Installation window.

IMPORTANT At the end of the installation process, the Release Notes display in a separate 
window. The installation process is not complete until you close the Release 
Notes window.
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Verify the AFServers Database and Account

Complete these steps to verify that the Historian AF database and user group 
were added to your computer.

1. Click the Programs icon and choose Microsoft SQL Server 2012>SQL 
Server Management Studio. 

2. Enter the server name. 
• The Server name is <ComputerName> if using SQL standard
• The Server name is <ComputerName>\SQLEXPRESS’ if using SQL 

Express.

IMPORTANT <ComputerName> = The computer name set in Configure Windows 
Settings on page 163
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3. Log on by using the ‘sa’ account and the password.

4. Click Connect.

5. From the SQL Server Management Studio configuration tree, expand 
the Databases folder and verify that PIFD appears in the list.

IMPORTANT After you complete the initial settings, change your logon and 
password settings under Options.
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6. Expand the Security\Logins folder and verify that the AFServers user 
group was added.

7. If the PIFD database or AFServers group do not appear, reinstall the 
Historian Asset Framework.

8. Close SQL Server Management Studio.
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Configure the FactoryTalk Directory

Complete these steps to configure the FactoryTalk directory.

1. Navigate to the FactoryTalk Directory Configuration Wizard.

2. Check both boxes under configure settings to configure the Network 
and Local directories and click Next.
184 Rockwell Automation Publication 9528-UM001G-EN-P - June 2019



Configure PASS-C / OWS ISO Chapter 6
3. Type the administrator user name and password.

4. Click Close in the summary window once complete.

Delete “Old” Computer Names from Directory

1. Navigate to 
Programs>Rockwell Software>FactoryTalk Administration Console.

2. Select Network (directory) and click OK.

3. Expand System>Computers and Groups>Computers in the explorer 
pane.

4. Right-click any old or unused computer names and choose Delete.

5. If a prompt appears, click Yes.

IMPORTANT Step 3 must be done twice. You have to enter a user name and 
password for each directory (local and network).
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6. Expand Users and Groups>User Groups in the explorer pane.

7. Right-click the IIS_IUSRS user group and choose Delete.

8. Click Yes.

9. Add the IIS_IUSRS user group and link with the new computer name.

From the Explorer pane, right-click the User Groups folder and choose 
New>Windows-Linked User Group.

10. Click Add.

11. Click Advanced.
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12. Click Find Now, select IIS_IUSRS, and click OK..

13. Verify that the user group is correct, and click OK.

14. Restart your computer.
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Configure FactoryTalk AssetCentre (FTAC)

1. Navigate to 
Programs>Rockwell Software>FactoryTalk Asset Centre Server>Server 
Settings.

2. Type a user name and password and click OK.

3. Type the new computer name and click Apply.

4. Click OK.

FactoryTalk AssetCentre Repair

Run FTAC repair to update FTAC with the new computer name.

1. Open the Server Setup folder on the desktop and run the 
FTAssetCentre.DbInstaller.exe.

2. Type a period (.) for the server name if using SQL Server Standard, or 
type “.\sqlexpress” if using SQL Server Express. 
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3. Log in by using the ‘sa’ and the password for your SQL server and click 
Start. 

The Database User Configuration dialog box appears.

4. Type your Username, Password, and click OK. 

The Install Shield Wizard Completed dialog box appears.
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5. If prompted to create a new user, click yes, and follow the prompts.

6. Open the Server Setup folder on the desktop and run the 
FTAssetCentre.AosCatalogImport.exe

7. Restart your computer.
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Configure FactoryTalk Historian

Remove Old Computer Names

1. Navigate to:
Programs>Rockwell Software>FactoryTalk Historian SE>FactoryTalk 
Historian SE System>AboutPI-SDK

2. In the left pane, click Connections, right-click the old server names, and 
choose Remove selected Server.

3. Close PI-SDK utility.

Install PI Builder Excel Add-in

PI Builder lets you import and export FactoryTalk Historian points and Asset 
Framework objects to and from a Microsoft Excel Add-in spreadsheet.

1. Double-click the PIAF client shortcut on the desktop.

2. Select Modify.

3. Click Next.

4. Leave the defaults checked and check the box for PI Builder.

5. Click Next.

6. Click Modify to begin installation.

7. Click Close.

IMPORTANT Microsoft Excel 2010 SP2 or later 32-bit software must be installed for these 
procedures.
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Complete Historian Configuration

When the template is installed, we recommend that you review a FactoryTalk 
publication at http://literature.rockwellautomation.com/idc/groups/
literature/documents/in/hse-in025.pdf ). 

IMPORTANT See the pages that are referenced in the FactoryTalk Historian SE Installation 
and Configuration Guide, publication HSE-IN025A:
• Verify that Historian Services are Running 
• Verify that Historian Server is Updating Data for Default Tags
• Prepare PI MDB to AF Synchronization
• Create Security Mappings
• Adding the Server to the FactoryTalk Directory Connection
• Assigning License Activations to the Historian Server 
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Configure FactoryTalk VantagePoint

1. Navigate to the folder:
C:\Install Files\8.10.00-VantagePoint-EMI-DVD 

2. Double-click setup.exe.

3. Click ‘Install FactoryTalk VantagePoint’.

4. Click ‘Install FactoryTalk VantagePoint’.

5. Click Next.

6. Read the license agreement, Check the box to accept the agreement, and 
click Next.

7. Click Custom setup type.
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8. Choose the following options and click Next.

9. Type a portal server name and click Next.
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10. If you are using SQL 2012 Standard, accept the defaults and click Next. 
If you are using SQL Express, enter “.\sqlexpress” for the server and then 
click Next.
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11. If you have a local user account that is specified for VantagePoint, type 
the user name in the prompt. Use the computer name as the domain. If 
you do not have a local user account, select Local Account and a user is 
created.

12. If Microsoft Excel is installed, the software automatically launches. 
Acknowledge the prompts and close Excel.
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13. Click Install.

14. Click Finish.

15. Wait for the installation to complete. A popup window appears that 
informs you the configuration is still running. It closes automatically.

16. Click Exit on the Vantage Point Installer.

17. Restart your computer.

IMPORTANT Installation can take 20…30 minutes.
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Install OWS ISO Complete these steps to install the OWS ISO.

1. Make sure that your computer is capable of booting from a USB drive. 
Enter the BIOS Setup as the computer is powering on (typically by 
pressing the F2 key). Make sure that the Boot options include booting 
from a USB device.

2. Shut down the computer and connect the USB drive.

3. Turn on the computer. While the computer is powering on, strike the 
F12 key to open the boot options screen. 

4. Select the USB device containing the OWS ISO installation.

5. On the Windows Setup dialog box, select your options from the
pull-down menus.

6. Click Next.

7. Click Install Now. 

8. Click “I accept the license terms”, and click Next.

9. Click Custom (installation).
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10. To store the installation, select the hard disk drive.

If necessary, delete any existing drive partitions and format the drive 
location.

11. Click Next.

The computer automatically restarts. You must log on to complete the 
installation.

12. Skip to the Configure Windows Settings procedure and complete 
chapter 3 starting on step 5 on page 152 to install OWS ISO.

TIP The installation typically takes about an hour.
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Notes:
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Activation Considerations

Use FactoryTalk Activations For continuous use of FactoryTalk® products and other Rockwell Automation® 
software products, computers running the software must have access to activation 
files. FactoryTalk Activation software provides a secure, software-based system 
for activating Rockwell Automation software products and managing software 
activation files. With FactoryTalk Activation software, there is no need for a 
physical master disk or any physical media. Instead, activation files are generated 
and distributed electronically.

Concurrent activations are locked to a central activation-server computer on the 
network. The activation server manages a pool of activation keys for connected 
clients to share. Floating concurrent activations are assigned automatically to 
clients that need them. These activations are returned automatically to the 
activation server pool when the software stops running on the client, or when the 
client computer shuts down.

Client computers must be configured to obtain floating activations from the 
activation server. A continuous network connection is also required for clients to 
use floating activations. After a client obtains a floating activation, if the 
activation server detects that the client has been disconnected, the activation is 
returned to the server pool.
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Table 7 - Activation Considerations

Consideration Details

Software that is not activated If the components you have installed cannot be activated, for example, because the activation server is unavailable, 
then the software continues to run for up to seven days. The seven-day grace period provides time to correct the 
problem with acquiring activations, without disrupting critical applications. If activation is restored within seven days, 
normal operations resume. If activation is not restored, the grace period expires. After the grace period expires, if you 
restart the components and activation remains unavailable, the software runs for two hours in Demo mode.

Location of activation server Activations for Rockwell Automation software can be stored local to the system element containing the Rockwell 
Automation software in question or remotely depending on your preferences and needs. Typically critical system 
elements keep their activations locally in case the connection with the remote activation location is lost. If you want to 
remotely activate Rockwell Automation software in non-critical system elements consider storing them in a system 
element with uninterrupted connection to your PlantPAx® DCS.  Keep in mind the information in Consideration section 
“Software that is not activated” when using a remote location for activations.

Options for adding activation files to the PASS To make concurrent floating activations available to activation clients, first you must download the activation files to 
the activation server computer, from the Rockwell Automation Activation window.
If the PASS has internet access, see ‘Open Activation Manager’ in the PlantPAx Distributed Control System Infrastructure 
Configuration User Manual, publication PROCES- UM001.
If the PASS does not have internet access, the activations can be downloaded on a different computer with internet 
connectivity and then transferred to the PASS.

Protect activation files Activation files are simple text files that must have a .lic extension. 
As long as the .lic extension is retained, you can copy or rename an activation file without harming it. However, 
tampering with text inside the activation file can disable your Rockwell Software products. 
If an activation file is damaged or deleted, contact Rockwell Automation Technical Support.
For safekeeping, keep an original set of your activation files on back-up media. Use descriptive names for the files, so 
that you can identify them later, and copy them back to the appropriate computers.
Activation files are locked to the Host IDs of the computers (or dongles) that need them. Activation fails for Rockwell 
Software products on a computer where the specified Host ID is not recognized by the activation file.
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FactoryTalk Activation Manager

FactoryTalk Activation software provides a secure, software-based system to 
apply Rockwell Automation licenses for continuous use of FactoryTalk software 
and other Rockwell Automation software products.

With FactoryTalk Activation software, there is no need for a physical master disk 
or any physical media. Instead, activation files are generated and distributed 
electronically.

On the selected Activation Manager computer, start the activation process by 
opening the FactoryTalk Activation Manager.

Click the Programs symbol and choose Rockwell Software>FactoryTalk 
Activation>FactoryTalk Activation Manager. 

The FactoryTalk Activation Manager window appears. For additional 
instructions and information on activation types, host IDs, and how to use a 
plug-and-play dongle, see Activate Rockwell Software Products, publication 
FTA-QS002. 

You also can use the website at https://activate.rockwellautomation.com.
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Use Windows License Keys This procedure enables you to enter your Product key and activate your 
Microsoft license. This procedure is also compatible with Windows and 
Windows Server.

Complete these steps to enter your product key to activate the Microsoft 
Windows operating system.

1. Right-click the Windows  icon and choose 'Command Prompt 
(Admin)'. 

2. At the command prompt, type 'slmgr /ipk <Product key>' and press Enter 
to add your volume license key. 

3. Click OK when a dialog box appears informing you that the product key 
installed successfully.

4. At the command prompt, type 'slmgr /ato' and press Enter to activate 
Windows.

5. Click OK when a dialog box appears informing you that the product 
activated successfully.

6. Close the command prompt window.
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Glossary

For definitions of terms not listed here, refer to the Allen-Bradley Industrial 
Automation Glossary, publication AG-7.1.

application server (AppServ) The application server (AppServ) is a server in addition to the Process 
Automation System Server (PASS) that is typically a FactoryTalk® Directory 
client of the PASS. Examples are AppServ-Batch for a FactoryTalk Batch 
application or AppServ-History for an Historian application.

architecture An architecture is a representation of a control and software system, as well as the 
process and discipline for effectively implementing the designs for such a system. 
An architecture conveys the information content of the related elements 
comprising a system, the relationships among those elements, and the rules 
governing those relationships.

Asset Framework Historian Asset Framework (AF) is a key component of the FactoryTalk 
Historian System that allows organization of data with context, such as the 
physical assets such as equipment, devices, and processing units that exist in a 
plant.

datastore Represents a storage location for virtual machine files. A storage location can be a 
virtual machine file system volume, a local file system path, or a directory on 
Network Attached Storage.

distributed control system (DCS) A specially designed control system for complex and large applications in 
industrial processes wherein the control elements of the system are distributed 
geographically throughout the plant. In a DCS, a hierarchy of controllers is 
connected by communication networks for command and monitoring.

engineering workstation (EWS) The engineering workstation (EWS) provides system configuration, 
development, and maintenance functions of the PlantPAx® system. The EWS 
contains development software, including FactoryTalk View SE Studio and 
Studio 5000 Logix Designer®.

ESXi hypervisor Also called a ‘bare metal’ hypervisor, this virtual software is on top of the 
resources of a host server when the server does not have an operating system 
installed. 

FactoryTalk directory software FactoryTalk Directory software defines were system data is stored for access. 
FactoryTalk Directory software provides a common address book of factory 
resources that are shared among FactoryTalk-enabled products.

flowchart A formalized graphic representation of a logic sequence, work, or manufacturing 
process, organization chart, or similar formalized structure.

guest OS The operating system of the virtual machine. The guest OS is one of the 
components of the virtual image.

historian An historian is a data collection system with the following components: 
collection, storage, compression, retrieval, reports, and analysis. Historian 
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functions include raw sampling, compression, storage, retrieval, reconstitute, 
analyze, summarize, and present (reports and displays).

historical data Historical data is data that is used for the long term analysis of past operation.

host OS The operating system of the host server. Servers without operating systems 
leverage an ESXi hypervisor to manage its resources and allocate them to the 
virtual machines that need them.

host server A physical server whose hardware resources are distributed to provide for the 
needs of the virtual machines deployed in it. Also called a hardware host.

hypervisor A program that lets multiple operating systems share resources from a single 
hardware host; also called a virtual machine manager. The hypervisor manages 
the host processor and resources, allocating what is needed to each virtual 
machine to make sure they cannot negatively impact each other.

hypervisor client A program that lets you remotely connect to a host server with a hypervisor from 
any workstation. From the hypervisor client, you can create, deploy, copy, and 
edit your virtual machines. When a hypervisor client connects to a vCenter 
server, additional features include management of your virtual machines.

old computer name The term ‘old computer name’ is used to refer to the computer name of the 
virtual machine prior to your changes. This reference could be the factory default 
computer name of the virtual machines or a computer name set by your 
organization. Once the computer name is changed, the previous computer name 
becomes the ‘old computer name’.

operator workstation (OWS) The operator workstation (OWS) provides the graphical view and interface into 
the process. The workstation is a client of either a PASS or AppServ-HMI.

PlantPAx Distributed Control
System

The PlantPAx system has all the core capabilities expected in a world-class 
distributed control system (DCS). The system is built on a standards-based 
architecture by using Integrated Architecture® components that enable
multi-disciplined control and premier integration with the Rockwell 
Automation® intelligent motor control portfolio.

Process Automation System Server
(PASS)

The Process Automation System Server (PASS) is the core PlantPAx system 
server allowing central administration throughout the PlantPAx system. The 
PASS is a required component.

RSLinx software RSLinx® software is the communication driver (data server) for computer-based 
programs to access information in Rockwell Automation controllers. There is 
RSLinx Classic software and RSLinx Enterprise software. FactoryTalk View SE 
software uses RSLinx Enterprise software to directly access tags in a controller.

server Software component that serves data to an application (for example, data server). 
Typically, server software components are installed on server-class computers.

system element A system element is a distinctive system entity made up of a combination of 
hardware and software products that support an identifiable system function or 
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role. A system element can be manipulated to vary system operation or capability. 
For example, engineering workstation (EWS), operator workstation (OWS), 
process automation system server (PASS), and controller.

virtual machine A virtual machine is a software implementation of a computer or workstation 
that executes programs like a physical computer or workstation. A virtual 
machine is the collection of dedicated resources a computer needs (for example, 
RAM, HDD, CPU, and so forth). These resources are allocated to a virtual 
machine with the help of a hypervisor.

virtualization Virtualization is the abstracting of the operating system from the hardware to 
enable multiple virtual machines on a single piece of hardware.

workstation A workstation is a computer running development, configuration, and optional 
maintenance software. A workstation is not a server.
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Rockwell Automation Support

Use the following resources to access support information.

Documentation Feedback

Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this 
document, complete the How Are We Doing? form at http://literature.rockwellautomation.com/idc/groups/literature/
documents/du/ra-du002_-en-e.pdf.

Technical Support Center Knowledgebase Articles, How-to Videos, FAQs, Chat, 
User Forums, and Product Notification Updates.

https://rockwellautomation.custhelp.com/ 

Local Technical Support Phone 
Numbers

Locate the phone number for your country. http://www.rockwellautomation.com/global/support/get-support-
now.page 

Direct Dial Codes Find the Direct Dial Code for your product. Use the 
code to route your call directly to a technical support 
engineer.

http://www.rockwellautomation.com/global/support/direct-dial.page 

Literature Library Installation Instructions, Manuals, Brochures, and 
Technical Data.

http://www.rockwellautomation.com/global/literature-library/
overview.page 

Product Compatibility and Download 
Center (PCDC)

Get help determining how products interact, check 
features and capabilities, and find associated 
firmware.

http://www.rockwellautomation.com/global/support/pcdc.page 

.

Rockwell Otomasyon Ticaret A.Ş., Kar Plaza İş Merkezi E Blok Kat:6 34752 İçerenköy, İstanbul, Tel: +90 (216) 5698400

Rockwell Automation maintains current product environmental information on its website at http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page.

Allen-Bradley, ControlFLASH Plus, eProcedure, FactoryTalk, Integrated Architecture, PlantPAx, Rockwell Automation, Rockwell Software, RSLinx, RSLogix, RSLogix 5000, RSNetWorx, Studio 5000 Architect, Studio 5000 Logix Designer, 
and TechConnect are trademarks of Rockwell Automation, Inc.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page
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